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About This Guide

This Novell® GroupWise® Gateway for Microsoft Exchange Installation and Administration 
Guide explains how to install, configure, and run the GroupWise Gateway for Microsoft 
Exchange. The guide is divided into the following sections: 

Chapter 1, “What Is the GroupWise Gateway for Microsoft Exchange?,” on page 11
Chapter 2, “Exchange Gateway System Requirements,” on page 13
Chapter 3, “Installing the Exchange Gateway,” on page 15
Chapter 4, “Configuring the Exchange Side of the Exchange Gateway,” on page 27
Chapter 5, “Configuring the GroupWise Side of the Exchange Gateway,” on page 35
Chapter 6, “Running the Exchange Gateway,” on page 39
Chapter 7, “Configuring the Exchange Gateway,” on page 45
Chapter 8, “Monitoring the Exchange Gateway,” on page 67
Chapter 9, “Optimizing the Exchange Gateway,” on page 81
Chapter 10, “Using Exchange Gateway Startup Switches,” on page 85
Appendix A, “Error and Informational Messages,” on page 93
Appendix B, “Exchange Gateway Directory Structure,” on page 109

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 6.5 
documentation Web site (http://www.novell.com/documentation/lg/gw65):

Installation

Administration

Multi-System Administration 

Interoperability

Troubleshooting

GroupWise Windows Client User Guide

GroupWise WebAccess Client User Guide

GroupWise Cross-Platform Client User Guide

Documentation Updates

For the most recent version of the GroupWise 6.x Gateway for Microsoft Exchange Installation 
and Administration Guide, visit the Novell GroupWise 6.5 documentation Web site (http://
www.novell.com/documentation/lg/gw65).
About This Guide 9
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with GroupWise. Please use the User Comment feature at the bottom of each page of the 
GroupWise online documentation.
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1 What Is the GroupWise Gateway for Microsoft 
Exchange?

The GroupWise® Gateway 2.0 for Microsoft Exchange connects a GroupWise system and an 
Exchange system by creating a link between a GroupWise domain and an Exchange server, as 
shown in the following diagram. 

Version 2.0 of the Exchange Gateway provides the following capabilities:

Message exchange between users of GroupWise 5.x and 6.x and users of Exchange 5.x and 
Exchange 2000.

Directory exchange, so that GroupWise users can be imported into the Exchange Address 
Book and Exchange users can be imported into the GroupWise Address Book. This enables 
users to select recipients from either system in their respective, familiar Address Books.

Directory synchronization, so that when users are added or removed, or user information is 
modified, the changes are automatically replicated between the GroupWise and Exchange 
systems. This keeps the GroupWise and Exchange Address Books up to date for all users.

Support Pack 1 for the GroupWise Gateway for Microsoft Exchange provides the following 
enhancements:

Microsoft Exchange 2000 is supported in addition to Exchange 5.x.

The Exchange Gateway has been updated to match GroupWise 6.x functionality in several 
areas.

The Exchange Gateway can run as a Windows* service as well as an application.

Busy Search is supported for GroupWise users who want to check the calendars of Exchange 
users. It is not supported for Exchange users to check GroupWise users’ calendars.

Internet-style addressing is supported.
What Is the GroupWise Gateway for Microsoft Exchange? 11
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SNMP is supported, so that the Exchange Gateway can be monitored from SNMP 
management and monitoring programs.

A Web console is provided, so that the Exchange Gateway can be monitored from any 
location where you have access to a Web browser and the Internet. 
12   GroupWise Gateway 2.0 for Microsoft Exchange Installation and Administration Guide
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2 Exchange Gateway System Requirements

The Windows machine on which you run the GroupWise® Gateway for Microsoft Exchange must 
meet the following system requirements.

Hardware/Software Minimum 
Requirements

Recommended 
Requirements

Computer Pentium* Pentium II or better

Windows NT* Server 
(for use with Microsoft Exchange 5.x)

Updated with  
Service Pack 6

Updated with  
Service Pack 6 or later

Windows 2000 Server  
(for use with Microsoft Exchange 5.x)

Updated with  
Service Pack 2

Updated with  
Service Pack 3 or later

Windows 2000 Server with Active Directory 
and the NNTP Service 
(for use with Microsoft Exchange 2000)

Updated with  
Service Pack 2

Updated with  
Service Pack 3 or later

Novell® ClientTM Any version Latest version

ConsoleOne® 1.3.4 Latest version

Available Disk Space 80 MB 80 MB or more

Available Memory 32 MB 64 MB or more

Exchange Server 4.0 5.0 updated with  
Service Pack 3 or later

GroupWise client 5.1 5.2 or later
Exchange Gateway System Requirements 13
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3 Installing the Exchange Gateway 

Before you install the GroupWise® Gateway for Microsoft Exchange, both the GroupWise system 
and the Exchange system should be running smoothly. Then complete the following tasks to 
connect the two systems through the Exchange Gateway:

“Planning the Exchange Gateway Installation” on page 15

“Meeting Installation Prerequisites” on page 21

“Installing the Exchange Gateway Software” on page 21

“Installing the Exchange Gateway Addressing Components” on page 22

“Installing the Exchange Gateway Administrator Snap-In to ConsoleOne” on page 23

“Exchange Gateway Installation Worksheet” on page 25

Planning the Exchange Gateway Installation
Before installing the Exchange Gateway, you should complete the planning tasks listed below. The 
planning tasks provide concepts and information you need as you install and set up the Exchange 
Gateway. You can use the “Exchange Gateway Installation Worksheet” on page 25 to record your 
installation and setup information.

“Gathering GroupWise System Information” on page 15

“Deciding Where to Install the Exchange Gateway” on page 16

“Choosing a Gateway Name” on page 16

“Deciding between Windows Application and Windows Service” on page 16

“Deciding How to Monitor the Exchange Gateway” on page 17

“Gathering Exchange System Information” on page 18

“Determining Connections between Systems” on page 19

“Selecting User Address Type and Format” on page 19

Gathering GroupWise System Information
The Exchange Gateway needs to access the GroupWise domain where you want to link the 
gateway into your GroupWise system. You might want to create a new domain specifically for the 
Exchange Gateway. This keeps Exchange Gateway activity separate from domains where post 
offices are located. If you create a new domain, you might want to create it on the Exchange server 
to minimize network traffic.
Installing the Exchange Gateway 15
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Deciding Where to Install the Exchange Gateway
You can install the Exchange Gateway on the same machine with the domain that the gateway 
belongs to, if that domain is located on Windows. You can also install the Exchange Gateway on 
a separate machine, regardless of the platform where the domain is located. The machine where 
you install the Exchange Gateway must be an Exchange server.

If you install the Exchange Gateway on a different machine from where the domain is located, you 
must provide a username and password for the gateway to use when logging in to the machine 
where the domain is located. The gateway requires Read, Write, Create, Erase, Modify, and File 
Scan rights in the domain directory.

Choosing a Gateway Name
When you install the Exchange Gateway, a Gateway object is created in the domain where you 
install the gateway. The default gateway name is exchange.

When you install the Exchange Gateway, a subdirectory for the gateway software and queues is 
created under the domain directory. By default, the directory name is the same as the object name. 
If you use the default object name of Exchange, the gateway subdirectory is 
domain\wpgate\exchange.

Deciding between Windows Application and Windows Service
You can install the Exchange Gateway as a Windows application or a Windows service. 

When you install the Exchange Gateway as an application, it can be manually started by a user or 
it can be added to a user’s Startup folder so that it starts automatically when the user logs in to the 
Windows machine. When running as an application, the Exchange Gateway displays a console on 
the Windows machine where you can monitor and control the gateway.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 4: eDirectory Information, list the Novell® eDirectoryTM tree and context where the Domain 
object is located. 

Under Item 5: Domain Information, list the domain name and domain directory. If you want to use a 
separate domain for the Exchange Gateway, create the new domain now.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 1: Exchange Gateway Location, mark whether you want to install the Exchange Gateway 
on the same server where the domain is located or on a remote server. For a remote server location, 
specify a username and password to provide login and access rights.

Under Item 3: Domain Server Type, mark whether the domain resides on a NetWare® or a Windows 
server.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 6: Gateway Name, specify the name you want to use for the Exchange Gateway object.
16   GroupWise Gateway 2.0 for Microsoft Exchange Installation and Administration Guide
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When you install the Exchange Gateway as a service, it can be configured to start automatically 
when the server starts and must run under a specific Windows user account that has rights to run 
services. When running as a service, the Exchange Gateway does not display a user interface on 
the Windows machine.

If you want to run the Exchange Gateway as a service and if the domain it belongs to is on a 
NetWare server (Item 3: Domain Server Type), you must create an eDirectory account with a 
username and password that match the Windows user account. The eDirectory user must have 
Read, Write, Compare, Edit, Modify, and File Scan rights to the domain\wpgate\exchange 
directory. 

Deciding How to Monitor the Exchange Gateway
If you install the Exchange Gateway as an application, the Exchange Gateway console is displayed 
on the Windows machine where the Exchange Gateway is running, which allows you to monitor 
the Exchange Gateway from that location. If you install the Exchange Gateway as a service, the 
Exchange Gateway console is not displayed, so you must plan for another way to monitor it.

“Using the Exchange Gateway Web Console” on page 17

“Using an SNMP Monitoring Program” on page 17

Using the Exchange Gateway Web Console

The Exchange Gateway Web console enables you to monitor and control the Exchange Gateway 
from any location where you have access to a Web browser and the Internet. This provides 
substantially more flexible access than the Exchange Gateway console or an SNMP monitoring 
program.

Using an SNMP Monitoring Program

If desired, you can monitor the Exchange Gateway from the Management and Monitoring 
component of Novell ZENworks® for Servers, ManageWise®, or any other SNMP management 
and monitoring program. When properly configured, the Exchange Gateway sends SNMP traps to 
network management consoles for display along with other SNMP monitored programs.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 8: Gateway Installation Method, mark whether you want to install and run the Exchange 
Gateway as an application or service. If you want to install it as a service, provide a username and 
password of the Windows account that you want to own the service. 

If the user account does not yet exist, create the user account now and give the account rights to run 
services.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 7: Web Console Information, provide a unique username and password to protect access 
to the Exchange Gateway Web console. Also provide an HTTP port number for communication 
between the Exchange Gateway and your browser. You might want to use a port number close to those 
used by the MTA and POA, for example, 7176.
Installing the Exchange Gateway 17
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You must enable SNMP during gateway installation. You cannot add this functionality after 
installation. In order for the option to be offered during installation, the Windows machine where 
you install the gateway must have the SNMP service installed.

The SNMP service is usually not included during the initial Windows operating system 
installation. To add or configure the SNMP service on the machine where you plan to install and 
run the Exchange Gateway, you must be logged in as a member of the Administrator group.

To add the SNMP service to a Windows NT machine:

1 From the Control Panel, double-click Network.

2 Click Services, click Add, then select SNMP Service.

3 Follow the on-screen prompts. You need your original Windows NT media.

You are given the opportunity to configure the SNMP service. The only required information 
for the Exchange Gateway is the Trap Destination and Community Name.

4 After the installation is complete, reboot the Windows NT machine.

For more information about configuring the SNMP service, see your Windows NT 
documentation. 

To add the SNMP service to a Windows 2000 machine:

1 From the Control Panel, double-click Add/Remove Programs.

2 Click Add/Remove Windows Components.

3 Select Management and Monitoring Tools.

4 Click Details, then select Simple Network Management Protocol.

5 After the installation is complete, reboot the Windows 2000 machine.

For more information about configuring the SNMP service, see your Windows 2000 
documentation. 

Gathering Exchange System Information
If you are using Exchange 5.5, you must know the name of the Exchange 5.5 site where you want 
to create the Exchange mailbox through which messages will flow to and from the GroupWise 
system.

If you are using Exchange 2000, you must know the name of the Exchange 2000 server, along with 
the name of the mailbox store where you want to create the Exchange mailbox and the name of the 
storage group where the mailbox store is located. You must also know the administrative group 
and routing group that the server belongs to.

In either case, you must have a list of all servers in your Exchange system. The Exchange Gateway 
needs to be installed on only one Exchange server, but the addressing components must be 
installed on all Exchange servers. The addressing components generate GroupWise-type addresses 
for Exchange users.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 9: Enable SNMP?, mark whether you want to configure the Exchange Gateway for SNMP.
18   GroupWise Gateway 2.0 for Microsoft Exchange Installation and Administration Guide
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Determining Connections between Systems
To facilitate addressing of messages between systems, you must set up a representation of the 
Exchange system in your GroupWise system and a connector to your GroupWise system in your 
Exchange system. 

In GroupWise, non-GroupWise systems are represented by non-GroupWise domains. When you 
first start the Exchange Gateway, the non-GroupWise domain for the Exchange system is created 
automatically. By default, it is named after the Exchange organization. Under the non-GroupWise 
domain for the Exchange system, an external post office is automatically created for the Exchange 
site or administrative group on the Exchange server. By default, it is given the same name as the 
Exchange site or administrative group. If necessary, you can specify different names for the non-
GroupWise domain and external post office. 

In Exchange, non-Exchange systems link to the Exchange system through connectors. On the 
Exchange side, you might want to call the Exchange Gateway GroupwiseConnector, because it 
connects the Exchange system to GroupWise.

Selecting User Address Type and Format
By default, every Exchange user will have a GroupWise-type address with the following format:

GWise:domain.post_office.user_ID

GWise is the default Exchange address type created for the GroupWise system. You can change 
it if needed.

Exchange user addresses are generated automatically when you start the Exchange Gateway, using 
the format shown above. As described earlier, the Installation program maps the name of the 

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 2: Exchange Server Information, list the Exchange system information required for your 
version of Exchange.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 12: Non-GroupWise Domain, mark whether you want to use the default name (the 
Exchange organization) or specify a name for the non-GroupWise domain.

Under Item 13: External Post Office, mark whether you want to use the default name (the Exchange 
site or administrative group) or specify a name for the external post office.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 6: Gateway Details, specify the name you want to use in Exchange to represent the link to 
the GroupWise system.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 11: GroupWise Address Type in Exchange System, mark whether you want to use the 
default address type (GWise) or specify the address type name you want to use.
Installing the Exchange Gateway 19
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Exchange organization to the GroupWise domain portion of the address, the name of the Exchange 
site or administrative group on the server to the post office portion of the address, and the 
Exchange user mailbox name to the GroupWise user ID portion of the address.

The recommendation is to use Exchange mailbox names as GroupWise user IDs. However, if this 
is not possible for some reason, the following variables can be used to specify the information you 
want to appear in the GroupWise user IDs:

Preferably, the GroupWise user IDs should include the Exchange mailbox names along with 
whatever other information you want to provide. For example, “%m_%d” would create 
GroupWise user IDs that consist of the Exchange mailbox names and users’ display names.

Determining Where to Install the Exchange Gateway Administrator Snap-In to 
ConsoleOne

Exchange Gateway administration is performed through ConsoleOne®, version 1.3.4 or later. 
When you install the Exchange Gateway, the Gateway Administrator snap-in files can be copied 
to a ConsoleOne location that you specify. The Gateway Administrator snap-in files extend the 
functionality of ConsoleOne to let you administer the Exchange Gateway. 

You must install the Gateway Administrator snap-in files to an installation of ConsoleOne on an 
Exchange server where the GroupWise Administrator snap-ins have already been installed. The 
Gateway Administrator snap-in cannot be installed to a workstation nor can it be used without the 
GroupWise Administrator snap-ins.

You can install the Gateway Administrator snap-in files to additional Exchange servers after you 
have installed the gateway, as described in “Installing the Exchange Gateway Administrator Snap-
In to ConsoleOne” on page 23.

Variable Description

%m Mailbox name (default)

%s Surname

%g Given name

%d Display name

$r char1 char2 Replace char1 with char2

%% Per cent sign character

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 14: Exchange User Address Format, mark whether you want to use the default GroupWise 
user ID format (Exchange mailbox name) or specify the format you want to use.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 2: Install Gateway Administrator Snap-In to ConsoleOne, specify the path for the 
ConsoleOne location you want to use to administer the Exchange Gateway.
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Meeting Installation Prerequisites
After you have gathered the information that the Exchange Gateway Installation program requires 
and have planned the information you need to configure the Exchange Gateway after installation, 
make sure that the Windows machine where you plan to install the Exchange Gateway meets the 
system requirements listed in Chapter 2, “Exchange Gateway System Requirements,” on page 13.

1 Make sure that the Novell ClientTM is installed.

The Installation program creates a Gateway object in eDirectory. The Novell Client is 
required to access eDirectory. If necessary, you can download the Novell Client from the 
Novell Product Downloads site (http://download.novell.com/filedist/pages/
PublicSearch.jsp).

2 Log in to the server where the domain directory resides and map a drive to the domain 
directory (worksheet item 5). 

The Installation program creates domain subdirectories and copies Exchange Gateway files 
to the subdirectories. This requires full file system rights to the domain directory. 

3 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where the Domain 
object resides (worksheet item 4).

The Installation program creates a Gateway object under the Domain object.

4 Continue with “Installing the Exchange Gateway Software” on page 21.

Installing the Exchange Gateway Software
1 Download the GroupWise Gateway for Microsoft Exchange from the Novell Product 

Downloads site (http://download.novell.com/filedist/pages/PublicSearch.jsp) into an empty 
directory on the machine where you want to install it (worksheet item 1).

The machine where you install the Exchange Gateway must be an Exchange server.

2 Run setupexch.exe to extract the Exchange Gateway files and start the Exchange Gateway 
Installation program on the Exchange server.

3 Click Next to view the license agreement, then click Accept to accept the license agreement.
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4 Select Install Gateway and Addressing Components.

5 If you want to install the Gateway Administrator snap-in to ConsoleOne on the Exchange 
server, select Install Gateway Snap-ins for ConsoleOne, then provide the path to the 
ConsoleOne installation (worksheet item 10).

6 Click Next.

7 Follow the prompts, using the information from items 2 through 9 on the “Exchange Gateway 
Installation Worksheet” on page 25 to install the Exchange Gateway
IMPORTANT: Do not start the Exchange Gateway after installation.

8 If your Exchange system consists of more than one server, continue with “Installing the 
Exchange Gateway Addressing Components” on page 22.

9 Continue with “Configuring the Exchange Side of the Exchange Gateway” on page 27.

Installing the Exchange Gateway Addressing Components
When you installed the Exchange Gateway, the Installation program automatically generated 
GroupWise-type addresses for all Exchange users on that server. If your Exchange system consists 
of multiple servers, you must install the Exchange Gateway addressing components on each 
server.

1 Plan the addressing format you want to use for users on the new server, as described 
in“Determining Connections between Systems” on page 19 and “Selecting User Address 
Type and Format” on page 19. 

2 If you are going to use customized address format, stop the Exchange Gateway.

3 At each Exchange server, run setupexch.exe to start the Installation program.
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4 Click Next to view the license agreement, then click Accept to accept the license agreement.

5 Select Install Addressing Components

6 Click Next to continue with the installation. 

The Installation program installs the gwproxy.dll file on each Exchange server.

7 Follow the instructions in “Configuring the Exchange Side of the Exchange Gateway” on 
page 27 to prepare the Exchange server to connect to the original Exchange server where the 
gateway is installed.

8 Continue with Chapter 6, “Running the Exchange Gateway,” on page 39.

Installing the Exchange Gateway Administrator Snap-In to 
ConsoleOne

After you have installed the Exchange Gateway, you can install the Exchange Gateway 
Administrator snap-in to Console One to additional Exchange servers as needed. The Gateway 
Administrator snap-in cannot be installed on a workstation.
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1 Make sure that no one is running ConsoleOne from the Exchange server where you want to 
install the Gateway Administrator snap-in.

2 At the Exchange server where you want to install the Gateway Administrator snap-in to 
ConsoleOne, run setupexch.exe to start the Exchange Gateway Installation program.

3 Click Next to view the license agreement, then click Accept to accept the license agreement.

4 Select Install Gateway Administrator Snap-Ins for ConsoleOne Only.

5 Select Install Gateway Administrator Snap-Ins for ConsoleOne, then specify the path to a 
ConsoleOne installation where you want to install the Gateway Administrator snap-in.

6 Click Next to continue with the installation. 
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Exchange Gateway Installation Worksheet

Item Explanation

1) Exchange Gateway Location

Domain machine

Remote machine 
Username: 
Password: 

Mark whether you want to install the Exchange Gateway on the same machine 
with the GroupWise domain it belongs to, or on a remote machine. 

For access to a remote machine, provide a username and password to facilitate 
logging in with the required rights. 

See “Deciding Where to Install the Exchange Gateway” on page 16.

2) Install Gateway Administrator Snap-In to 
ConsoleOne?

Yes 
ConsoleOne Path:

No

Mark whether you want to install the Exchange Gateway Administrator snap-in to 
ConsoleOne at the same time when you install the Exchange Gateway. If you do, 
record the path where ConsoleOne and the GroupWise Administrator snap-ins to 
ConsoleOne are currently installed. 

See “Determining Where to Install the Exchange Gateway Administrator Snap-In 
to ConsoleOne” on page 20.

3) Exchange Server Information:

Exchange 5.5 Server

Site

Exchange 2000 Server

Administrative Group

Routing Group

Exchange Server

Storage Group

Mailbox Store

Servers in Your Exchange System:

 

 

 

Provide the required information for your version of the Exchange server, along 
with a list of all servers in your Exchange system.

See “Gathering Exchange System Information” on page 18.

4) Domain Server Type:

NetWare

Windows

Mark the platform of the machine where the gateway’s domain is located. 

See “Gathering GroupWise System Information” on page 15.

5) eDirectory Information:

Tree

Domain Object Context

Specify the eDirectory tree and context where the Domain object is located. The 
Exchange Gateway object will be created in the Domain object. 

See “Gathering GroupWise System Information” on page 15

6) GroupWise Domain Information:

Domain Name

Domain Directory

Specify the domain name and directory. The Exchange Gateway will be installed 
in a subdirectory under the domain. 

See “Gathering GroupWise System Information” on page 15
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7) Gateway Details:

Gateway Object Name on Exchange 
Server

Gateway Object Name in GroupWise 
System

Gateway Directory

Specify the name of the Exchange Gateway object in the Exchange system and 
in the GroupWise system, as well as the subdirectory in the domain where the 
Exchange Gateway software will be installed. The default is Exchange.

See “Choosing a Gateway Name” on page 16

8) Web Console Information:

Username

Password

HTTP Port

Specify the information required to enable the Exchange Gateway Web console. 

See “Deciding How to Monitor the Exchange Gateway” on page 17.

9) Gateway Installation Method:

Application

Service 
User: 
Password:

Mark whether you want to install the Exchange Gateway as a Windows 
application or a Windows service. 

If you want to install it as a service, provide a username and password of the 
Windows account that will own the service. 

See “Deciding between Windows Application and Windows Service” on page 16. 

10) Enable SNMP?

Yes

No

Mark whether you want to enable SNMP. 

See “Deciding How to Monitor the Exchange Gateway” on page 17.

11) GroupWise Address Type in Exchange 
System:

GWise (default)

Custom

Mark whether you want to use the default address type of GWise or a custom 
address type. If you do not want to use GWise, specify the address type you want 
to use for addressing messages to GroupWise users.

See “Selecting User Address Type and Format” on page 19

12) Non-GroupWise Domain:

Exchange organization (default)

Custom

Mark whether you want to use the name of the Exchange organization as the 
name of the non-GroupWise domain that represents the Exchange system in 
GroupWise. If you do not want to use the default, specify the name for the non-
GroupWise domain.

See “Determining Connections between Systems” on page 19.

13) External Post Office:

Exchange site or  
administrative group (default)

Custom

Mark whether you want to use the name of the Exchange site or administrative 
group as the name of the external post office that represents the collection of 
Exchange users on the server where you are installing the Exchange Gateway. If 
you do not want to use the default, specify the name for the external post office.

See “Determining Connections between Systems” on page 19.

14) Exchange User Address Format

Exchange mailbox name (default)

Custom

Mark whether you want to use the Exchange mailbox name as the GroupWise 
user ID for each Exchange user. 

See “Selecting User Address Type and Format” on page 19.

Item Explanation
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4 Configuring the Exchange Side of the Exchange 
Gateway

After you install the Exchange Gateway software but before you start the Exchange Gateway for 
the first time, you must prepare your Exchange system to link to your GroupWise® system:

“Configuring Exchange 5.x” on page 27

“Configuring Exchange 2000” on page 30

Configuring Exchange 5.x
1 Start Exchange Administrator.

2 Expand the Exchange site, expand the Configuration container, then select the Connections 
container.

3 Double-click the Exchange Gateway object (worksheet item 6), then click Export Containers.
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4 Select the Recipient containers that contain users whose Address Book information you want 
to export into the GroupWise system, then click Add.

5 In the Trust Level field, select a trust level number that is larger than the trust level numbers 
of the users you want to export.
IMPORTANT: Directory synchronization and exchange cannot occur if the trust level of one or more 
gateway users is less than that of the Gateway object.

6 Click OK to save the export information.

7 Make sure that the Exchange services are running.

7a On the Control Panel, double-click Services.

7b Scroll down to check the status of the following services:

Microsoft Exchange Directory 
Microsoft Exchange Event Service 
Microsoft Exchange Information Store 
Microsoft Exchange Message Transfer Agent 
Microsoft Exchange System Attendant

7c If any of the Microsoft Exchange services are not running, start them now.

8 If you want to customize the name of the non-GroupWise domain that represents the 
Exchange system, the external post office that represents the Exchange site, or the format of 
GroupWise-type usernames for Exchange users, continue with “Customizing Addressing for 
Exchange 5.x” on page 29.

or

Continue with Chapter 5, “Configuring the GroupWise Side of the Exchange Gateway,” on 
page 35
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Customizing Addressing for Exchange 5.x
1 In Exchange Administrator, expand the Site container, then select the Configuration 

container.

2 Double-click the Site Addressing object, then click the Site Addressing tab.

If no GroupWise-specific address type appears in the list, then the addressing components 
have not been installed on the server. See “Installing the Exchange Gateway Addressing 
Components” on page 22.

3 Select GWISE (or your custom address type for GroupWise), then click Edit.
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4 To change the name of the non-GroupWise domain that you want to represent your Exchange 
system, replace the Exchange organization with the domain name you want to use worksheet 
item 12).

5 To change the name of the external post office, replace the Exchange site with the post office 
name you want to use (worksheet item 13).

6 To change the format of the GroupWise usernames that will be generated for Exchange users, 
specify the desired address format (worksheet item 14).

7 Click OK to save the addressing information.

8 Back on the Site Addressing tab, click OK.

9 Continue with Chapter 5, “Configuring the GroupWise Side of the Exchange Gateway,” on 
page 35

Configuring Exchange 2000
1 Start System Manager program. 

If you do not see the Administrative Groups object, right-click the Organization object, then 
click Properties. Select Display Administrative Groups and Display Routing Groups, then 
click OK.

2 Expand Administrative Groups, then Expand First Administrative Group (or whatever your 
system’s administrative group is).
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3 Expand Routing Groups, then expand First Routing Group (or whatever your system’s routing 
group is).

4 Expand Connections, right-click the Gateway object, then click Properties.

5 Click Modify, enter the administrator username and password, then click OK.

6 Click the Export Containers.

7 Click Add, select the container that contains users whose addresses and information you want 
to export to the GroupWise system (for example, the Users container), then click OK.
IMPORTANT: Directory synchronization and exchange cannot occur if you have not added any user 
containers to the Export Containers property page.
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8 Expand Servers, then expand the Server object for your server.

9 Expand First Storage Group (or whatever your system’s storage group is).

10 Right-click Mailbox Store, click Properties, then click Security.
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11 Add the user to log in to the Exchange services and the Windows server (if the user has not 
been added already). 

12 Scroll to the bottom of the Permissions list, grant the user Send As and Receive As 
permissions, then click OK.

13 Make sure that the Exchange services are running.

13a On the Control Panel, double-click Services.

13b Scroll down to check the status of the following services:

Microsoft Exchange Event 
Microsoft Exchange IMAP4 
Microsoft Exchange Information Store 
Microsoft Exchange Management 
Microsoft Exchange MTA Stacks 
Microsoft Exchange POP3 
Microsoft Exchange Routing Engine 
Microsoft Exchange Site Replication Service 
Microsoft Exchange System Attendant

13c If any of the Microsoft Exchange services are not running, start them now.

14 If you want to customize the name of the non-GroupWise domain that represents the 
Exchange system, the external post office that represents the Exchange administrative group, 
or the format of GroupWise-type usernames for Exchange users, continue with “Customizing 
Addressing for Exchange 2000” on page 33.

or

Continue with Chapter 5, “Configuring the GroupWise Side of the Exchange Gateway,” on 
page 35

Customizing Addressing for Exchange 2000
1 In System Manager, expand the Recipients container, then select the Recipient Policies 

container.

2 Right-click the Default Policy object, click Properties, then click the E-Mail Addresses 
(Policy) tab.
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If no GroupWise-specific address type appears in the list, then the addressing components 
have not been installed on the server. See “Installing the Exchange Gateway Addressing 
Components” on page 22.

3 Select GWISE (or your custom address type for GroupWise), then click Edit.

4 To change the name of the non-GroupWise domain that you want to represent your Exchange 
system, replace the Exchange organization with the domain name you want to use worksheet 
item 12).

5 To change the name of the external post office, replace the Exchange administrative group 
with the post office name you want to use (worksheet item 13).

6 To change the format of the GroupWise usernames that will be generated for Exchange users, 
specify the desired address format (worksheet item 14).

7 Click OK

8 Back on the Default Policy properties dialog box, click OK again to save the address format.

9 Continue with Chapter 5, “Configuring the GroupWise Side of the Exchange Gateway,” on 
page 35
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5 Configuring the GroupWise Side of the 
Exchange Gateway

After you have configured the Exchange side of the gateway, you must configure the GroupWise® 
side of the gateway by configuring the Exchange Gateway object in ConsoleOne®.

“Providing Gateway Information” on page 36

“Providing Foreign System Configuration Information” on page 35

Providing Foreign System Configuration Information
1 In ConsoleOne, connect to the domain where you installed the Exchange Gateway (worksheet 

item 4), then select the Domain object.

2 Right-click the Exchange Gateway object, then click Properties.

3 Click Default to populate the fields.
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The defaults are typically acceptable, but you can change the information if needed.

Address: Specify the name of the Exchange address type (worksheet item 11) that you want 
the gateway to create in the Exchange system. The default is GWise.

Administrator: Specify the name and e-mail address of the administrator of the Exchange 
system.

Converters: The locations of the conversion DLLs is provided automatically.

4 Click Apply to save the foreign system configuration information.

5 Continue with “Providing Foreign System Configuration Information” on page 35.

Providing Gateway Information
1 On the Exchange Gateway object, click Identification.
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2 Fill in the following fields on the Identification page:

Description: This field is optional. If desired, provide any descriptive information about the 
gateway.

Subdirectory: Displays the name of the Exchange Gateway root directory specified during 
installation. The default is exchange.

Time Zone: Displays the time zone of the domain where the gateway is installed.

Database Version: Select 5.0 if you have installed the Exchange Gateway in a GroupWise 
5.x system. Select 6 if you have installed the gateway in a GroupWise 6.x system.

Platform: Displays Windows as the default platform.

Gateway Type: Defaults to Exchange.

Gateway Alias Type: Specify Exchange.

3 Click OK to save the gateway information.

You have now provided sufficient configuration information to start the Exchange Gateway.

4 Continue with “Running the Exchange Gateway” on page 39.
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6 Running the Exchange Gateway

After you have installed the Exchange Gateway software and configured both sides of the 
gateway, you are ready to start the gateway.

“Starting the Exchange Gateway” on page 39

“Acquainting E-Mail Users with the Exchange Gateway” on page 40

“Stopping the Exchange Gateway” on page 42

“Uninstalling the Exchange Gateway” on page 42

After the Exchange Gateway has started successful, continue with Chapter 7, “Configuring the 
Exchange Gateway,” on page 45

Starting the Exchange Gateway
Before you start the Exchange Gateway, make sure that it has network access to the following 
locations:

The GroupWise® domain directory and subdirectories where you installed the gateway files. 
The gateway requires Read, Write, Create, Erase, Modify, and File Scan rights.

The Exchange server. You should have already provided access when you configured the 
Exchange side of the gateway, as described in Chapter 4, “Configuring the Exchange Side of 
the Exchange Gateway,” on page 27.

Follow the instructions for the installation method you chose for the Exchange Gateway 
(worksheet item 7):

“Starting the Exchange Gateway As a Windows Application” on page 39

“Starting the Exchange Gateway As a Windows Service” on page 40

IMPORTANT: After you start the gateway, stop and then start the MTAs in the GroupWise system. This 
establishes the links to the non-GroupWise domain that represents the Exchange system.

Starting the Exchange Gateway As a Windows Application
1 At the Windows machine where you installed the Exchange Gateway, click Start > Programs.

2 Click GroupWise Exchange Gateway > Exchange > GroupWise Exchange Gateway. 
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When running as an application, the Exchange Gateway console appears on the machine 
while it is running. For instructions on interpreting the information displayed on the Exchange 
Gateway console, and for information about other monitoring alternatives, see Chapter 8, 
“Monitoring the Exchange Gateway,” on page 67.

3 Stop and then start the MTAs in the GroupWise system.

This establishes the links to the non-GroupWise domain that represents the Exchange system.

4 After the Exchange Gateway has started successfully and the links between systems have been 
established., continue with Chapter 7, “Configuring the Exchange Gateway,” on page 45.

Starting the Exchange Gateway As a Windows Service
1 At the Windows machine where you installed the Exchange Gateway, click Start > Settings > 

Control Panel.

2 Double-click Services.

In the alphabetical list of services, the name of the Exchange Gateway service starts with the 
name of the domain where the gateway is installed, followed by the name of the gateway 
itself, followed by Service. For example, if the domain is named Connector and the gateway 
is named Exchange, then the name of the service would be ConnectorExchangeService.

3 Select the gateway service, then click Start.

When running as a service, the Exchange Gateway does not have a console on the machine 
where it is running. However, you can monitor it in other ways, as described in Chapter 8, 
“Monitoring the Exchange Gateway,” on page 67.

4 Stop and then start the MTAs in the GroupWise system.

This establishes the links to the non-GroupWise domain that represents the Exchange system.

5 After the Exchange Gateway has started successfully and the links between systems have been 
established, continue with Chapter 7, “Configuring the Exchange Gateway,” on page 45.

Acquainting E-Mail Users with the Exchange Gateway
After you have started the Exchange Gateway, GroupWise users and Exchange users need only 
the following information in order to start using the gateway immediately:
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“Addressing Messages” on page 41

“Understanding What GroupWise Send Options Are Available through the Gateway” on 
page 41

Addressing Messages
If you have set up directory synchronization and exchange, as described in “Enabling Directory 
Synchronization and Exchange of Address Books” on page 45, GroupWise users can select 
Exchange users from the GroupWise Address Book, and Exchange users can select GroupWise 
users from the Exchange Address Book.

If you have not set up directory synchronization and exchange, you should explain to GroupWise 
users how to add Exchange users to their personal address books, as described in “Adding 
Individual Exchange Users to Personal Address Books” on page 49. You should also explain to 
both GroupWise users and Exchange users how to manually type addresses in the To field of 
messages.

Understanding What GroupWise Send Options Are Available through the Gateway
GroupWise users can use some, but not all, GroupWise send options through the Exchange 
Gateway. The following GroupWise send options are supported:

Priority (high, normal, low)

Classification (normal, proprietary, confidential, secret, top secret, for your eyes only)

Reply Requested (when convenient or within x days)

Delay Delivery (deliver item after x days)

Notify Recipients (if enabled as described in “Enabling Message Status for Sent Items” on 
page 65)

The following GroupWise send options are not supported:

Expiration Date (after x days)

Auto-Delete (when the last recipient has deleted the message)

Conceal Subject

Require Password to Complete Routed Item

Sign Digitally

Encrypt for Recipients

GroupWise  
to Exchange 
        

Syntax: 
gateway_name:exchange_organization.exchange_site.recipient's_mailboxt_name

Examples: 
Exchange:XYZCorp.Provo.SJones

Exchange  
to GroupWise 

Syntax: 
address_type:domain.post_office.user_ID

Examples: 
GWise:Corporate.Marketing.LTanaka
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Stopping the Exchange Gateway
Occasionally, it might be necessary to stop the gateway to perform maintenance on the Windows 
machine or for some other purpose. When you stop the gateway, any messages being sent from 
GroupWise users are queued in one of the domain\wpgate\exchange\wpcsout\ngaxxxx\0-7 
directories. Messages sent from Exchange users are moved to the gateway’s mail store. The 
messages waiting in each system are processed as soon as the gateway is started again.

Follow the instructions for the installation option you chose for the Exchange Gateway:

“Stopping the Exchange Gateway If It Is Running As an Application” on page 42

“Stopping the Exchange Gateway If It Is Running As a Service” on page 42

Stopping the Exchange Gateway If It Is Running As an Application
1 At the Exchange Gateway console, click File > Exit.

or

Press F7.

2 Click Yes to stop the gateway.

Stopping the Exchange Gateway If It Is Running As a Service
1 At the Exchange Gateway console, click Start > Settings > Control Panel.

2 Double-click Services.

3 Select the Exchange Gateway service, then click Stop.

Recall that the Exchange Gateway Service is named after the domain and gateway.

Uninstalling the Exchange Gateway
If you need to remove the Exchange Gateway from the machine where you installed it, follow the 
instructions for the installation option you chose when installing the Exchange Gateway:

“Uninstalling the Exchange Gateway As an Application” on page 42

“Uninstalling the Exchange Gateway As a Service” on page 43

Uninstalling the Exchange Gateway As an Application
1 At the Windows machine where you installed the Exchange Gateway, click Start > Programs 

> GroupWise Exchange Gateway > Exchange > Uninstall.

2 If a message informs you that some files could not be deleted, delete the 
domain\wpgate\exchange directory.

3 In ConsoleOne, delete the Exchange Gateway object from the domain.
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Uninstalling the Exchange Gateway As a Service
1 At the Windows machine where you installed the Exchange Gateway, click Start > Settings > 

Control Panel.

2 Double-click Add/Remove Programs, select domain.gateway (Exchange Gateway), then 
click OK.

3 If a message informs you that some files could not be deleted, delete the 
domain\wpgate\exchange directory.

4 In ConsoleOne, delete the Exchange Gateway object from the domain.
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7 Configuring the Exchange Gateway

After the Exchange Gateway is up and running between the GroupWise® system and the Exchange 
system, there are a variety of ways to refine its configuration to meet the specific needs of your e-
mail users.

“Enabling Directory Synchronization and Exchange of Address Books” on page 45

“Configuring Addressing” on page 47

“Controlling Gateway Access” on page 54

“Setting Up Accounting” on page 61

“Establishing Gateway Administrators” on page 64

“Enabling Message Status for Sent Items” on page 65

Enabling Directory Synchronization and Exchange of Address 
Books

Directory synchronization and exchange enable the Exchange Gateway to automatically exchange 
Address Book information between the GroupWise system and the Exchange system. 

Directory Exchange: Causes the gateway to perform a nightly exchange of the Exchange 
public Address Book and GroupWise Address Book.

Directory Synchronization: Causes the gateway to update each Address Book as changes in 
Address Book information occur. If directory synchronization is not enabled, the Address 
Books are not updated until the nightly directory exchange occurs.

IMPORTANT: To ensure proper replication of names and addresses in both systems, use both directory 
synchronization and exchange.

1 Make sure that the Exchange system is set up to support directory synchronization and 
exchange, as described in Chapter 4, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 27. You might want to double-check the trust level established for the 
gateway.

2 If you have domains in your GroupWise system that contain users that you do not want to 
appear in the Exchange version of the GroupWise Address Book, use the /blockdom switch 
in the startup files (gwexch.cfg) to list the GroupWise domains that should not be included in 
the directory synchronization and exchange process.

3 In ConsoleOne®, browse to and select the domain where you installed the Exchange Gateway, 
right-click the Exchange Gateway object, then click Properties to display the gateway 
Identification page.

4 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.
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5 In the Directory Sync/Exchange field, select Both, then click OK.

ConsoleOne passes the directory synchronization and exchange information to the Exchange 
Gateway so that it can start transferring user information. The larger the Address Books are, 
the longer the process takes.

6 If you edited the gwexch.cfg file in Step 2, stop and then start the Exchange Gateway so that 
it reads the updated startup file.

When you first started the Exchange Gateway, a non-GroupWise domain representing the 
Exchange system was created automatically. It was named after the Exchange organization. Under 
the non-GroupWise domain, an external post office was created for each Exchange site or server 
and given the same name as the corresponding Exchange site or server. However, no user 
information was transferred at that time.

Now that you have enabled directory synchronization and exchange, Exchange users are added to 
these external post offices as external GroupWise users.

You can see the results of directory synchronization and exchange in the following locations:

Exchange users appear in ConsoleOne because External User objects are created in the 
External Post Office object that represents the Exchange site or administrative group.

Exchange users appear in the GroupWise Address Book because they have External User 
objects in the GroupWise system.

GroupWise users appear in the Exchange Address Book because the Exchange Gateway 
creates recipient addresses based on the GroupWise address type, as described in “Selecting 
User Address Type and Format” on page 19.

Related Startup Switches 
You can use the /allowdom and /blockdom startup switches in the Exchange Gateway startup file 
(gwexch.cfg) to control which GroupWise domains have their users displayed in the Exchange 
Address Book.
46   GroupWise Gateway 2.0 for Microsoft Exchange Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  22 July 2004
Exchange Gateway Web Console 
You can see whether directory synchronization and exchange are enabled on the Configuration 
page. You can turn directory synchronization and exchange on and off for the current gateway 
session on the Optional Gateway Settings page.

Configuring Addressing
When you take advantage of directory synchronization and exchange, as described in “Enabling 
Directory Synchronization and Exchange of Address Books” on page 45, GroupWise users and 
Exchange users can select each other out of their familiar Address Books. Addressing is not an 
issue under these circumstances.

If you do not want to enable directory synchronization and exchange, you must use other 
addressing alternatives:

“Adding Individual Exchange Users to the GroupWise Address Book” on page 47

“Adding Individual Exchange Users to Personal Address Books” on page 49

“Adding Individual GroupWise Users to the Exchange Address Book” on page 50

“Using Explicit Addressing” on page 53

Adding Individual Exchange Users to the GroupWise Address Book
If there are some specific Exchange users who you want to appear in the GroupWise Address 
Book, you can add those individual users without enabling directory synchronization and 
exchange. You add Exchange users to the GroupWise Address Book by defining them as external 
users and then specifying the explicit addresses required to route messages to them in the 
Exchange system.

1 In ConsoleOne, select GroupWise System, select the non-GroupWise domain that represents 
the Exchange system, then select the external post office that represents the Exchange site or 
administrative group where the Exchange user is located.

2 Right-click the GroupWise Post Office object that represents the Exchange site or 
administrative group, then click New > External User.

3 Type a username, then click OK.

4 Right-click the new External User object, then click Properties.
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5 Fill in fields as needed to provide information about Exchange the user that you want to appear 
in the GroupWise Address Book.

6 Click Apply to save the user information.

7 Click GroupWise > Gateway Aliases to display the Gateway Aliases page.

You use the Gateway Aliases page to define the explicit address required to route messages 
to the user in the Exchange system.

8 Click Add to display the Create Alias dialog box.
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9 Fill in the following fields:

Gateway Alias Type: From the list, select the Exchange Gateway.

The gateway alias type was defined during configuration of the gateway. If there is no 
gateway alias type listed for the gateway, you can define one now. See “Providing Gateway 
Information” on page 36.

Gateway Alias: Specify the user's address as defined in Exchange.

For an example, see “Addressing Messages” on page 41.

10 Click OK to save the gateway alias and return to the Gateway Alias page.

The gateway alias is now listed in the Gateway Alias list.

11 Click OK to save the list.

ConsoleOne passes the alias information to the Exchange Gateway so that the Exchange user 
is added to the GroupWise Address Book.

12 Repeat Step 2 through Step 11 for each Exchange user you want to add to the GroupWise 
Address Book.

Adding Individual Exchange Users to Personal Address Books
GroupWise users can also add Exchange users to their personal address books if the Exchange 
users are not already defined in the GroupWise Address Book. 

1 In the GroupWise Windows client, click Tools > Address Book to open the Address Book.

2 Select a personal address book.

3 Click New > Contact > OK.
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4 Fill in the following fields:

First: Specify the user's first name.

Last: Specify the user's last name.

E-mail Address: Specify the explicit address required to route a message to the Exchange 
user. For syntax and examples, see “Addressing Messages” on page 41.

5 Click OK to save the new contact in the personal address book.

Adding Individual GroupWise Users to the Exchange Address Book
If there are some specific GroupWise users who you want to appear in the Exchange Address 
Book, you can add those individual users without enabling directory synchronization and 
exchange. You add GroupWise users to the Exchange Address Book by defining them as custom 
recipients and then specifying the explicit addresses required to route messages to them in the 
GroupWise system. You can also configure the Exchange Gateway to perform directory 
synchronization and exchange for them.

“Adding GroupWise Users in Exchange 5.x” on page 50

“Adding GroupWise Users in Exchange 2000” on page 51

“Including Custom Users in Directory Synchronization” on page 53

Adding GroupWise Users in Exchange 5.x

1 Start Exchange Administrator.

2 Expand the Recipients container.

3 Select an existing container.

or

Create a new container for GroupWise recipients.

3a Click File > New Other > Recipients Container.

3b Specify a name for the new container; for example, GroupWise Recipients.

3c Specify a directory for the new container.

3d Click OK.
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4 Select the container in which you want to create a custom recipient to represent a GroupWise 
user, then click File > New Custom Recipient.

5 Select GWISE Address, then click OK.

6 In the Display Name field, specify the full name of the GroupWise user.

7 In the Address field, specify the GroupWise user’s address in the following format:

domain.post_office.user_ID

where domain is the name of the GroupWise domain, post_office is the name of the 
GroupWise post office, and user_ID is the user’s GroupWise ID.

8 Click OK.

9 In the Properties dialog box, specify whatever information you want to be available about the 
GroupWise user, then click OK.

The GroupWise user can now be selected from the Exchange Address Book.

Adding GroupWise Users in Exchange 2000

1 On the Windows desktop, click Programs > Microsoft Exchange > Active Directory Users 
and Computers.
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2 Expand the Users container, select the container in which you want to create a Contact, then 
click Action > New > Contact.

3 Specify the information about the GroupWise user that you want to be available in the 
Exchange Address Book, then click Next.

4 In the E-mail Address field, click Modify.
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5 Select Novell GroupWise Address, then click OK.

6 In the Address field, specify the GroupWise user’s address in the following format:

domain.post_office.user_ID

where domain is the name of the GroupWise domain, post_office is the name of the 
GroupWise post office, and user_ID is the user’s GroupWise ID.

7 Click OK, click Next, then click Finish.

The GroupWise user can now be selected from the Exchange Address Book.

Including Custom Users in Directory Synchronization

If you want to be able to change user information associated with custom recipients in Exchange 
and have the information for the corresponding GroupWise user updated to match, you must 
enable directory synchronization for custom recipients. In the Exchange Gateway startup file 
(gwexch.cfg), use the /custom startup switch to enable directory synchronization for custom 
recipients. For more information about directory synchronization, see “Enabling Directory 
Synchronization and Exchange of Address Books” on page 45.

Using Explicit Addressing
If you do not enable directory synchronization and exchange, and if users are not represented in 
the other e-mail system’s Address Book, then users on both sides of the gateway must use explicit 
addressing. See “Addressing Messages” on page 41.

Setting Up an Addressing Rule to Facilitate Busy Searches
When performing a busy search, the Exchange server uses LDAP to identify the users being 
searched, rather than the typical recipient information used when delivering messages. If users’ e-
mail addresses do not match their mailbox names, messages are delivered successfully but busy 
searches fail. 
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You can use the /addressrule startup switch in the gwexch.cfg file to define the format you want 
the gateway to use when it sends a busy search request to the Exchange system. With the /
addressrule startup switch, you can use the following tags to specify the address format you want:

<domain> 
<username> 
<firstname> 
<lastname> 
<firstinitial> 
<lastinitial>

Each tag is replaced with the corresponding user-specific information. Additional text can be 
added to the address format as well.

Examples: 
/addressrule-<firstname>_<lastname>@<domain> 
/addressrule-<firstname>.<lastname>@<domain> 
/addressrule-<username>@exchange.<domain>

These address rules would result in the following addresses for a user named Sophie Jones at 
Corporate.com:

Sophie_Jones@Corporate.com 
Sophie.Jones@Corporate.com 
SJones@exchange.Corporate.com

Controlling Gateway Access
The Exchange Gateway lets you control access through the gateway. For example, you can:

Control which GroupWise users can send messages and to which Exchange users

Control which GroupWise users can receive messages and from which Exchange users

Control the maximum size for messages sent through the gateway

Control whether or not rule-generated GroupWise messages are sent through the gateway

The standard way to control access for all GroupWise and Exchange users on the GroupWise side 
of the gateway is with the access.cfg file in the domain\wpgate\exchange directory. In addition, 
you can control individual user access using the Gateway Access field of individual User objects 
in ConsoleOne.

“Using the Access.cfg File in the Gateway Directory” on page 54

“Using the Gateway Access Field on Individual User Objects” on page 59

On the Exchange side of the gateway, access control is provided on the Permissions page of the 
Site Addressing object. See your Exchange documentation for more information.

Using the Access.cfg File in the Gateway Directory
The access.cfg file is an ASCII text file that can be edited with a standard text editor. It is located 
in the gateway root directory (for example, domain\wpgate\exchange). The access.cfg file enables 
you to implement the following specific types of access control:

Provide specific access control based on GroupWise domains and post offices

Provide specific access control based on access groups that you define
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Limit the size of incoming and outgoing messages to and from your GroupWise system for 
specific domains, post offices, or access groups

Prevent messages from specific addresses from entering your GroupWise system for specific 
domains, post offices, or access groups

Allow messages from specified addresses to enter your GroupWise system, while preventing 
all others for specific domains, post offices, or access groups

Prevent rule-generated messages from going out of your GroupWise system for specific 
domains, post offices, or access groups

The initial access.cfg file includes descriptions and examples of the section headers and keywords 
that you can use in the file. However, all lines are initially commented out and access control is off 
by default. Print the initial access.cfg file in the domain\wpgate\exchange directory. Reviewing the 
file can help you understand how it works.

Add the following line at the top of the file to turn on access control:

Access Control=On

After access control has been turned on, you can create sections in the access.cfg file for various 
groups of users. Section headers are enclosed in square brackets ([header]). Within each section, 
you use keywords to define the access control settings for the group to which the section applies. 
The following section headers and keywords are available:

Section headers, keywords, and settings are not case sensitive. The In and Out directions are from 
the point of view of the GroupWise system. Semicolons (;), slashes (/), and pound signs (#) can be 
used to comment out lines of text. In the examples provided in the access.cfg file, the string 
gwaddresstext represents the address of an Exchange user. For example, you could replace 
gwaddresstext with Novell.Sales.Glen if that is the appropriate address format, as explained in 
“Selecting User Address Type and Format” on page 19.

Exchange Gateway Web Console 
You can turn access control on and off for the current gateway session on the Access Control page. 
You can also adjust the maximum message size.

Section Headers

Section headers establish groups of users to which access control settings are applied.

“[Default:In|Out]” on page 56

“[groupwise_domain:In|Out]” on page 56

“[groupwise_domain.post_office:In|Out]” on page 56

“[AccessGroup:group_name]” on page 57

Section Headers Keywords

[Default:In|Out] 
[groupwise_domain:In|Out] 
[groupwise_domain.post_office:In|Out] 
[AccessGroup:group_name]

AllAccess 
NoAccess 
Block 
Allow 
MaxSize 
AllowRuleGenerated
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[Default:In|Out]

This section lists the access control settings for users who are not covered by access control 
settings for a particular GroupWise domain, post office, or access group.

Syntax: 
[Default:In] 
[Default:Out

Examples: 
[Default:In] 
MaxSize=100000 
[Default:Out] 
AllowRuleGenerated=No

This example limits incoming messages to 100 KB but does not limit the size of outgoing 
messages. It prevents rule-generated GroupWise messages from transferring through the gateway 
to the Exchange system. These access control settings would apply to any users who did not fall 
under a more specific section header.

[groupwise_domain:In|Out]

This section lists the access control settings for users in a particular GroupWise domain.

Syntax: 
[groupwise_domain:In] 
[groupwise_domain:Out]

Examples: 
[Corporate:In] 
MaxSize=100000000 
[Corporate:Out] 
AllowRuleGenerated=Yes

This example limits incoming messages to 1 MB but does not limit outgoing messages. It allows 
GroupWise users to send rule-generated messages.

[groupwise_domain.post_office:In|Out]

This section lists the access control settings for users in a particular GroupWise post office.

Syntax: 
[groupwise_domain.post_office:In] 
[groupwise_domain.post_office:Out]

Examples: 
[Corporate.Temps:In] 
Allow NetTech 
MaxSize=10000 
[Corporate.Temps:Out] 
Allow NetTech 
MaxSize=10000 
AllowRuleGenerated=No

This example allows users in the Temps post office to exchange messages with users in the 
Exchange NetTech system only. It restricts incoming and outgoing messages to 10 KB. It prevents 
rule-generated messages.
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[AccessGroup:group_name]

This section lists the access control settings for individual GroupWise users who are assigned to 
the access group in ConsoleOne, as described in “Using the Gateway Access Field on Individual 
User Objects” on page 59. Access groups do not have direction parameters. If you want to control 
access in both directions, you must create separate access groups.

Syntax: 
[AccessGroup:group_name]

Examples: 
[AccessGroup:SysAdminsIn] 
MaxSize=5000000 
[AccessGroup:SysAdminsOut] 
MaxSize=5000000 
AllowRuleGenerated=Yes

This example allows users in the SysAdminsIn and SysAdminsOut access groups to receive 
messages up to 5 MB in size and to send rule-generated messages. 

Keywords

Keywords define the access control settings for the users included under each section header.

“AllAccess” on page 57

“NoAccess” on page 57

“Block” on page 58

“Allow” on page 58

“MaxSize” on page 59

“AllowRuleGenerated” on page 59

AllAccess

This keyword provides unrestricted access to the Exchange Gateway for those GroupWise users 
specified by the section header. Users can send messages to or receive messages from Exchange 
users, depending on the direction specified by the header.

Examples: 
[Corporate.Executives:In] 
AllAccess 
[Corporate.Executives:Out] 
AllAccess

This example allows all GroupWise users in the Executives post office to exchange messages with 
all Exchange users with no access control restrictions.

NoAccess

This keyword restricts access to the Exchange Gateway for those GroupWise users specified by 
the section header. Users cannot send or receive messages through the gateway, depending on the 
direction specified in the header.

Examples: 
[Corporate.Temps:In] 
NoAccess 
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[Corporate.Temps:Out] 
NoAccess

This example prevents all GroupWise users in the Temps post office from exchanging messages 
with Exchange users.

Block

This keyword restricts access to the Exchange Gateway from the perspective of Exchange users. 
This keyword differs from NoAccess because a specific Exchange address must be specified. If 
GroupWise users try to send mail to a Exchange address that has been blocked, they receive a 
message from the gateway stating that the message is undeliverable.

Syntax: 
Block exchange_server 
Block username@exchange_server 
Block CN=full_name/O=organization@exchange_server

Examples: 
[Corporate.Temps:In] 
Block XYZCorp 
[Corporate.Temps:Out] 
Block XYZCorp

[Corporate.Executives:In] 
Block SJones@XYZCorp 
Block CN=Sophie Jones/O=Sales@XYZCorp

The first example prevents GroupWise users in the Temps post office from exchanging messages 
with users in the Exchange XYZCorp system. The second example prevents GroupWise users in 
the Executives post office from receiving messages from a specific Exchange user. Providing the 
username in both formats is required to totally block a user.

Allow

This keyword allows messages to pass through the Exchange Gateway only if the message's 
recipient matches the Exchange address specified on the Allow line. Any messages addressed to 
other Exchange addresses are blocked.

Syntax: 
Allow exchange_server 
Allow username@exchange_server 
Allow CN=full_name/O=organization@exchange_server

Examples: 
[Corporate.Temps:In] 
Allow NetTech 
[Corporate.Temps:Out] 
Allow NetTech

[Default:In] 
Allow SJones@XYZCorp 
Allow CN=Sophie Jones/O=Sales@XYZCorp

The first example allows GroupWise users in the Temps post office to exchange messages with 
the NetTech Exchange system but no others. The second example allows all users to receive 
messages from a specified user. 
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MaxSize

This keyword determines the maximum size of messages that the Exchange Gateway can transfer 
between systems. Maxsize is specified in bytes (1000 = 1000 bytes or 1 KB), with a range from 0 
to 2147483647.

Unless you have a reason to limit the message size (for example, you are charged for the amount 
of data transferred by the gateway), you might not want to limit the message size. When 
attachments are encoded as they pass through the gateway, they generally become larger.

Syntax: 
Maxsize=number _of_bytes

Example: 
[Corporate.Temps:In] 
MaxSize=1000000 
[Corporate.Temps:Out] 
MaxSize=5000000

This example prevents GroupWise users in the Temps post office from receiving messages larger 
than 1 MB and from sending messages larger than 5 MB.

AllowRuleGenerated

This keyword determines whether or not rule-generated messages are allowed through the 
Exchange Gateway. It applies only to outbound messages from GroupWise to Exchange.

You could use this keyword to control rule-generated messages such as "On Vacation" from 
entering the Exchange system. Unlike NoAccess and Block, the gateway does not generate a status 
message stating that the mail message was undeliverable. Instead, the message remains pending in 
the sender's mailbox.

Syntax: 
AllowRuleGenerated=Yes | No

Example: 
[Default:Out] 
AllowRuleGenerated=No

This example prevents all rule-generated messages from transferring from the GroupWise system 
to the Exchange system.

Using the Gateway Access Field on Individual User Objects
You can use the Gateway Access field on the GroupWise Account page of each User object in 
ConsoleOne to control individual user access. This can be useful if you only have a few users 
whose access you want to control. If you have many users whose access you want to control, you 
should use the access.cfg file, as described in “Using the Access.cfg File in the Gateway 
Directory” on page 54.

1 If desired, create an access control group in the access.cfg file.

2 In ConsoleOne, browse to and right-click the user whose access you want to control, then 
click Properties.

3 Click GroupWise > Account to display the Account page.
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4 Fill in the Gateway Access field. 

If you created an access control group in the access.cfg file in Step 1, specify the name of the 
access control group that you want this user to be associated with.

If you have not created an access control group, you can put access control information unique 
to this user in the Gateway Access field.

Syntax: 
gateway.direction:keyword,keyword,...,keyword;gateway.direction:keyword,...,keyword

The following keywords are valid in the Gateway Access field:

AllAccess

NoAccess

MaxSize

AllowRuleGenerated
IMPORTANT: The Block and Allow keywords cannot be used in the Gateway Access field. They can 
only be used in the access.cfg file.

Example: 
Exchange.Out:MaxSize=500000,AllowRuleGenerated=No;Exchange.In:Maxsize=500000

In this example, the gateway name is Exchange, the maximum message size is 500 KB, and 
rule-generated messages are prevented from leaving the GroupWise system. The gateway 
direction designations and their keywords are separated by a semicolon (;).

5 Click OK to save the access control information for the selected user.

ConsoleOne passes the access control information to the Exchange Gateway so that the access 
control settings are in force immediately.
60   GroupWise Gateway 2.0 for Microsoft Exchange Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  22 July 2004
Setting Up Accounting
Every day at midnight, the Exchange Gateway creates an accounting file (acct) in the 
domain\wpgate\exchange\000.prc directory. The acct file is an ASCII-delimited text file that 
records the source, priority, message type, destination, and size of each item passing through the 
gateway. 

“Enabling Accounting” on page 61

“Defining an Accountant” on page 62

“Understanding the Accounting File” on page 63

Enabling Accounting
1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.

2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.

3 Make sure Accounting is set to Yes.

4 Click Apply to save your changes.

5 Continue with “Defining an Accountant” on page 62.

Exchange Gateway Web Console 
You can turn accounting on and off for the current gateway session on the Optional Gateway 
Settings page.
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Defining an Accountant
1 On the Exchange Gateway object, click GroupWise > Gateway Administrators to display the 

Gateway Administrators page.

The Gateway Administrators page lets you select a GroupWise user to be the Accountant for 
the Exchange Gateway. Each night at midnight, the gateway mails the accounting file (acct) 
to the Accountant.

2 Click Add to open the Select GroupWise Object dialog box, then select a user to function as 
the Accountant for the Exchange Gateway.

You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

3 Click OK to return to the Gateway Administrators page.

4 In the Administrators list, select the user or distribution list that you want to function as the 
Accountant.

In the Administrators list, you can also select multiple users and distribution lists as needed.

5 In the Administrator Role box, select Accountant.

6 Click OK to save the changes.

ConsoleOne passes the accounting information to the Exchange Gateway so that the 
Accountant can begin receiving daily accounting files.

7 Continue with “Understanding the Accounting File” on page 63.
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Understanding the Accounting File
The accounting file (acct) is an ASCII-delimited text file that records the source, priority, message 
type, destination, and other information about each message sent through the gateway. The file, 
which is updated daily at midnight is located in the domain\wpgate\exchange\000.prc directory. If 
no Accountant is defined to receive the file, the file is deleted each day.

A sample line from an accounting file is shown below:

O,05/18/03, 20:42:55,, 
     Mail,3,Corporate,Temps,LTanaka,,Reminder,Connector,Exchange,, 
     Mail,SJones@Provo,1,0,2593

Each item sent through the gateway is recorded on a separate line, with the fields separated by 
commas. Two or more commas in a row indicate that a field has no data. The following table 
describes the fields in the order in which they are found in the accounting file.

Field Description Example

In/Out Status Indicates if the message is outbound (O) or inbound (I) O

Message Date The date when the message was sent 5/18/03

Message Time The time when the message was sent 20:42:55

GroupWIse Message ID A set of numbers that uniquely identifies the message 
in the GroupWise system

3F429BA6.961 : 
12 : 31746

GroupWise Message 
Type

Type of item sent or received Mail

GroupWise Message 
Priority

0 = High 
2 = Normal 
4 = Low

2

GroupWise User Domain The GroupWise domain where the sender’s or 
receiver’s post office is located

Corporate

GroupWise User Post 
Office

The GroupWise post office that the sender or recipient 
belongs to

Temps

GroupWise User ID The user ID of the sender or recipient LTanaka

GroupWise Account ID The recipient’s or sender's account ID as specified on 
the user's GroupWise Account page in ConsoleOne

Message Subject The subject line of the message Reminder

Gateway Domain The GroupWise domain where the gateway is installed Connector

Gateway Name The name of the gateway as defined in GroupWise Exchange

Foreign Message ID The message ID supplied by Exchange

Foreign Message Type The type of message sent from Exchange Mail

Foreign Address The user's Exchange address or GroupWise address 
(if the user was added to a non-GroupWise domain)

Corporate.Marke
ting.LTanaka

Number of Recipients The number of users 1
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The acct file can be imported into a word processor, spreadsheet, or database program for further 
analysis.

Establishing Gateway Administrators
A gateway administrator is any GroupWise user you assign to receive information and error 
messages from the Exchange Gateway. The gateway does not require an administrator, but if you 
want to define one, the administrator must either be a user who is associated with GroupWise or 
with a GroupWise distribution list. There are several types of administrators that you can define 
for the Exchange Gateway:

1 In ConsoleOne, browse to and select the Exchange Gateway object, then click Properties.

2 Click GroupWise > Gateway Administrators to display the Gateway Administrators page.

Number of Attachments The number of files attached to the message 0

Accounting Units The byte size of the message 2593

Administrator Type Description

Operator The Operator receives a message if the Exchange Gateway cannot 
communicate with the GroupWise system.

Foreign Operator The Foreign Operator receives a message if the Exchange Gateway cannot 
communicate with the Exchange system.

Postmaster The Postmaster receives bad message files if the /badmsg switch is in use. 
See “Notifying the Exchange Gateway Administrator about Bad Messages” on 
page 80.

Accountant The gateway keeps accounting records for every message it sends, unless you 
turn the Accounting feature off. Accounting data for the previous day's activity 
is sent daily to the Accountant. For setup information, see “Setting Up 
Accounting” on page 61.

Field Description Example
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3 Click Add to display the Select Object dialog box, then select the user you want to define as 
an administrator.

You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

4 Click OK to return to the Gateway Administrators page and add the user to the Gateway 
Administrators list. 

5 In the Administrator Role box, select the type of administrator you want the user to be.

Operator

Accountant

Postmaster 

Foreign Operator

6 Click OK to save the Exchange Gateway administrator list.

ConsoleOne passes the administrator information to the Exchange Gateway so that the 
administrators start receiving the appropriate types of messages.

Enabling Message Status for Sent Items
Both GroupWise and Exchange can return status information to message senders. This lets senders 
know if their messages have been delivered, opened, and so on. In order for message status 
information to be returned to senders, you need to make sure that message status has been enabled. 
Message status information is collected in the status correlation database (gwcorr.db), located by 
default in the domain\wpgate\exchange directory. 

1 If you want to change the location of the status correlation database, use the /corr startup 
switch in the Exchange Gateway startup file (exchange.cfg) to specify a different directory.

2 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.

3 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.
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4 Fill in the following fields:

Outbound Status Level: Outbound status refers to the status information returned to 
GroupWise users for messages they send to Exchange users. Select Undelivered, Delivered, 
Open, or Full (which is equivalent to choosing Undelivered, Delivered, and Open). 

Correlation Enabled: Select Yes. Message correlation is used to map Exchange delivery, 
non-delivery, and receipt reports to GroupWise status messages, and GroupWise status 
messages to Exchange delivery, non-delivery, and receipt reports. For tracking purposes, each 
message receives its own record in the correlation database 
(domain\wpgate\exchange\gwcorr.db).

Correlation Age: Specify the number of days you want a message's record to remain in the 
correlation database. After a message's record has been deleted, any status information 
returned on the message is sent to the user as a new message rather than as status information 
on the old message.

5 Click OK to save the changes.

ConsoleOne passes the status message information to the Exchange Gateway so that status 
messages and correlation start immediately.

6 If you edited the exchange.cfg file in Step 1, stop and then start the Exchange Gateway so that 
it reads the updated startup file.

Exchange Gateway Web Console 
You can adjust these settings for the current gateway session on the Optional Gateway Settings 
page.
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8 Monitoring the Exchange Gateway

By monitoring the Exchange Gateway, you can determine whether or not its current configuration 
is meeting the needs of the users it services. You have a variety of tools to help you monitor the 
operation of the Exchange Gateway:

“Using the Exchange Gateway Console” on page 67

“Using the Exchange Gateway Web Console” on page 70

“Using Exchange Gateway Log Files” on page 76

“Using SNMP Monitoring Programs” on page 77

“Notifying the Exchange Gateway Administrator about Bad Messages” on page 80

“Understanding Exchange Gateway Error Messages” on page 80

Using the Exchange Gateway Console
The Exchange Gateway console displays the gateway's activity when it is running as an 
application. If you run the Exchange Gateway as a Windows service, the console does not appear 
and you must use other monitoring alternatives, as described in “Using the Exchange Gateway 
Web Console” on page 70 and “Using SNMP Monitoring Programs” on page 77.

To properly administer the gateway as an application, you should understand the console and how 
it works. The screen is divided into various areas.

“Information Box” on page 68

“Status Box” on page 68

“Statistics Box” on page 68
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“Log Message Box” on page 69

“Menu Summary” on page 69

Information Box
The top portion of the console provides the following information about the gateway. 

Domain.Gateway: The domain where the gateway is installed and the name of the gateway.

UpTime: The length of time the gateway has been running.

Description: The description you added when you configured the gateway, as described in 
“Providing Gateway Information” on page 36.

Status Box
The Status box provides the following information:

Processing: If the gateway is running, this field displays a spinning bar. If there is no bar or if the 
bar is stationary for an extended period, the gateway is not running.

GroupWise: Whether the gateway's network connection to the GroupWise® domain is Open or 
Closed. It is normal for this field to briefly display Closed while the gateway is initializing. If the 
link shows Closed for an extended period, a network failure, insufficient access rights, or an error 
in setup fields could be the problem. Check for error messages in the Log Message box. For 
assistance resolving error messages, see Appendix A, “Error and Informational Messages,” on 
page 93.

Other Link: The status of the gateway's network connection to the Exchange system. Messages 
can be sent or received if Other Link is Open. If it is Closed, the network connection has been 
terminated. Check the status of the Exchange system.

Program: Where the gateway is in its current processing cycle (sending, receiving, or idle). You 
can use the Gateway Time Settings page in ConsoleOne® to adjust the processing cycle. For more 
information, see “Adjusting the Gateway’s Send/Receive Cycle” on page 81.

Log Level: The logging level the gateway is currently using. The level determines how much 
information is displayed in the Logging box and written to the log file. You can set the default 
logging level in ConsoleOne, as described in “Using Exchange Gateway Log Files” on page 76. 
You can also change the log level for the current Exchange Gateway session, as described in 
“Menu Summary” on page 69.

Statistics Box
The Statistics box displays the amount of incoming and outgoing gateway traffic. The four 
columns display the cumulative totals and the snap shot totals. The four columns from left to right 
are: outgoing message totals, snap shot of outgoing messages (the default snap shot interval is 10 
minutes), incoming message totals, and snap shot of incoming messages.

The snap shot interval statistic can help you get a more accurate picture of the amount of recent 
gateway traffic. For information about changing the snap shot interval, see “Adjusting the 
Gateway’s Send/Receive Cycle” on page 81

The following types of status information are provided:

Normal: The number of normal incoming and outgoing messages the gateway has processed.
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Status: The number of status messages the gateway has sent and received. The amount of status 
message traffic depends in part on the outbound status level of the gateway. An outbound status 
level set to Full causes more status messages than an outbound status level set to Undelivered. For 
more information about setting the outbound status level, see “Enabling Message Status for Sent 
Items” on page 65.

Passthru: The number of incoming and outgoing passthrough messages the gateway has 
processed. Using the Exchange Gateway as a passthrough gateway between two GroupWise 
systems is not a recommended way to connect GroupWise systems. There are better alternatives 
currently available. See the GroupWise 6.5 Multi-System Administration Guide for preferred 
alternatives.

Conv Errors: The number of conversion errors for incoming and outgoing messages.

Comm Errors: The number of communications errors for incoming and outgoing messages.

Total Bytes: The total number of bytes for the incoming and outgoing messages.

Log Message Box
The Log Message box displays the Exchange Gateway’s activity. The amount and detail in this 
display depends on the logging level you select. For more information, see “Using Exchange 
Gateway Log Files” on page 76.

For assistance with error messages that appear in the Log Message box, see Appendix A, “Error 
and Informational Messages,” on page 93.

Menu Summary
At the top of the Exchange Gateway console is a menu bar that provides the following 
functionality:

Menu Item Function Key Function

File Exit F7 Stop the Exchange Gateway.

Configuration Gateway  
Settings

F5 Display the gateway configuration settings from the 
Exchange Gateway object in Novell® eDirectoryTM. For 
more information, see Chapter 5, “Configuring the 
GroupWise Side of the Exchange Gateway,” on 
page 35 and various sections in Chapter 6, “Running 
the Exchange Gateway,” on page 39.

Log View Log Files F9 Select a log file and view it in Notepad. See “Using 
Exchange Gateway Log Files” on page 76.

Log Settings F2 Override the default log settings for the current 
Exchange Gateway session. See “Using Exchange 
Gateway Log Files” on page 76.

Actions Zero Status F8 Reset all statistics to zero.
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Using the Exchange Gateway Web Console
The Exchange Gateway Web console enables you to monitor and control the Exchange Gateway 
from any location where you have access to a Web browser and the Internet. This provides 
substantially more flexible access than the Exchange Gateway console, which can be accessed 
only from the Windows machine where the Exchange Gateway is running.

“Setting Up the Exchange Gateway Web Console” on page 70

“Accessing the Exchange Gateway Web Console” on page 72

“Monitoring the Exchange Gateway from the Web Console” on page 72

Setting Up the Exchange Gateway Web Console
During installation, the Installation program offered you the opportunity to set up the Exchange 
Gateway Web console.

The information that you provided during installation was recorded in the Exchange Gateway 
startup file (gwexch.cfg). If you want to change the information provided during installation, you 
must edit the startup file. As an alternative, you can remove the Web console information from the 
startup file and configure the Web console in ConsoleOne as described below.

If you did not enable the Web console during installation, you can do it in ConsoleOne.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.

2 Click GroupWise > Network Address to display the Network Address page.
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3 In the HTTP Port field, provide a unique port number for communication between the 
Exchange Gateway and your Web browser. 

You might want to use a port number close to those used by the MTA and POA, for example, 
7176.

4 Make a note of the HTTP port number. You need this information in order to access the 
Exchange Gateway Web console.

5 Click Apply to save your changes on the Network Address page.

If you want to limit access to the Exchange Gateway Web console, you can provide a 
username and password.

6 Click GroupWise > Optional Gateway Settings.

7 In the HTTP Settings box:

7a In the HTTP User Name field, specify a unique username.
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7b Click Set Password.

7c Type the password twice for verification.

7d Click Set Password.

Do not use an eDirectory username and password because the information passes over the 
insecure connection between your Web browser and the Exchange Gateway.

For convenience, use the same username and password for all GroupWise agents and 
gateways that you plan to monitor from GroupWise Monitor. This saves you from having to 
provide the username and password information as Monitor accesses each agent and gateway.

8 Click OK to save the Exchange Gateway Web console settings.

ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

Corresponding Startup Switches: 
You could also use the /httpport, /httpuser, and /httppassword startup switches in the Exchange 
Gateway startup file (gwexch.cfg) to enable and secure the Exchange Gateway Web console. In 
addition, you can use the /httprefresh switch to control how often the Exchange Gateway refreshes 
the information provided to your Web browser.

Accessing the Exchange Gateway Web Console
To monitor the Exchange Gateway from your Web browser, view the URL where the Exchange 
Gateway is located by supplying the network address of the Windows machine where the Gateway 
runs and the port number as provided on the Network Address page in ConsoleOne.

Syntax: 
http://IP_address_or_hostname:HTTP_port

Examples: 
http://172.16.5.18:7176

http://exchserver1:7176

Monitoring the Exchange Gateway from the Web Console
The Exchange Gateway Web console provides several pages of information to help you monitor 
the performance of the Exchange Gateway. The bar at the top of the Exchange Gateway Web 
console displays the name of the Exchange Gateway and its post office. Below this bar appears the 
Exchange Gateway Web console menu that lists the pages of information available in the 
Exchange Gateway Web console. 
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Monitoring Gateway Status

When you first access the Gateway Web console, the Status page is displayed.

The information is the same as is displayed on the Gateway console on the Windows machine 
where the gateway runs. For more information, see “Status Box” on page 68.

Checking Gateway Configuration

On the Exchange Gateway Web console menu, click Configuration to display the configuration 
information stored on various property pages on the Exchange Gateway object in ConsoleOne.

To change the log settings for the current gateway session, click Event Log Settings. All other 
settings listed on the Configuration page must be changed in ConsoleOne.

Checking the Operating System Environment

On the Exchange Gateway Web console menu, click Environment to display information about 
the operating system where the Exchange Gateway is running. 
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Viewing Gateway Log Files

On the Exchange Gateway Web console menu, click Log Files to display gateway log files.

Click Event Log Settings to change the log settings for the current Exchange Gateway session. 

For information about Exchange Gateway log files, see “Using Exchange Gateway Log Files” on 
page 76.

Checking and Changing Gateway Time Settings

On the Exchange Gateway Web console menu, click Time Settings to display the settings listed 
on the Time Settings page in ConsoleOne.
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Modify the settings as needed, then click Submit to change them for the current Exchange 
Gateway session. For information about the time settings, see “Adjusting the Gateway’s Send/
Receive Cycle” on page 81.

Checking and Changing Optional Gateway Settings

On the Exchange Gateway Web console menu, click Optional Gateway Settings to display the 
settings listed on the Optional Gateway Settings page in ConsoleOne.

Modify the settings as needed, then click Submit to change them for the current Exchange 
Gateway session. For information about the optional gateway settings, see the following topics:

“Enabling Directory Synchronization and Exchange of Address Books” on page 45

“Setting Up Accounting” on page 61

“Enabling Message Status for Sent Items” on page 65

“Using Exchange Gateway Startup Switches” on page 85

Changing Gateway Access Control

On the Exchange Gateway Web console menu, click Access Control to turn access control on and 
off and to adjust the maximum message size for the current Exchange Gateway session.

For information about access control, see “Controlling Gateway Access” on page 54.
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Using Exchange Gateway Log Files
Log files record all message routing data that appears in the Log Message box of the Exchange 
Gateway console. You can determine the level of information you want to log, as well as the 
maximum age for log files and the maximum amount of disk space to be used for log files. 
Examining log files is useful if you experience any problems with the Exchange Gateway, because 
the log files record the exact route all messages take. If you have any problems that require 
assistance from Novell Support, it is likely that the technician who helps you will request a copy 
of this file. 

Log files are stored in the gateway's 000.prc directory (domain\wpgate\exchange\000.prc) and can 
be viewed from the gateway console and the Web console. Log files are named mmddlog.nnn, 
where mmdd is the month and day and nnn is an incrementing number, starting with 001.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.

2 Click GroupWise > Log Settings to display the Log Settings page.

3 Fill in the following fields:

Log File Path: Select the path where the log file should be created. By default, log files are 
stored in the domain\wpgate\exchange\000.prc directory.

Logging Level: Select the logging level you want. Gateway logging levels are hierarchical, 
with Off as the lowest and Diagnostic as the highest.

Off: Disables logging.

Normal: Displays basic message routing information, providing a summary of gateway 
activity. This is the default setting.

Verbose: Displays extra message routing details and message processing information.

Diagnostic: Displays all message routing and processing information. You should use 
this logging level only when troubleshooting a problem with the gateway.
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A new log file is created each day, and the files accumulate according to the following 
settings:

Max Log File Age: Specify the maximum number of days you want to save the log file before 
the gateway deletes it. The default value is 7 days.

Max Log Disk Space: Specify the amount of disk space you want the limit to be for log files. 
When the limit is reached, the gateway deletes the oldest file until the space occupied is under 
the maximum allowable limit. The default value is 1024 KB.

If you set the limit to zero (0), there is no disk space limit for log files.

4 Click OK to save the log settings.

ConsoleOne passes the updated log settings to the Exchange Gateway so that the new log 
settings are in force immediately.

Corresponding Startup Switches 
You could also use the /log, /loglevel, /logdays, and /logmax startup switches in the Exchange 
Gateway startup file (gwexch.cfg) to control logging.

Exchange Gateway Web Console 
You can view the Exchange Gateway log files and change the log settings for the current Exchange 
Gateway session by clicking the Log Settings link on the Log Files page. You can also view and 
modify log settings at the Exchange Gateway console on the machine where the gateway is 
running, as listed in “Menu Summary” on page 69.

Using SNMP Monitoring Programs
You can monitor the Exchange Gateway from the Management and Monitoring component of 
Novell ZENworks® for Servers, ManageWise®, or any other SNMP management and monitoring 
program. When properly configured, the Exchange Gateway sends SNMP traps to network 
management consoles for display along with other SNMP monitored programs.

During installation, you had the opportunity to configure the Exchange Gateway for SNMP. If the 
option was dimmed, then SNMP was not installed on the Windows server.

If you did not select SNMP support during installation, there is currently no way to add the 
functionality short of uninstalling the Exchange Gateway and reinstalling it. See “Uninstalling the 
Exchange Gateway” on page 42
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To set up SNMP services for the Windows machine, complete the following tasks:

“Copying and Compiling the Exchange Gateway MIB File” on page 78

“Configuring the Exchange Gateway for SNMP Monitoring” on page 78

Copying and Compiling the Exchange Gateway MIB File
An SNMP-enabled Exchange Gateway returns information contained in a Management 
Information Base (MIB). The MIB is an ASCII data structure that defines the information 
gathered. It also defines the properties that can be monitored and managed on the SNMP-enabled 
Exchange Gateway. You can view the contents of the Exchange Gateway MIB for a description 
of the SNMP variables available for it. The Exchange Gateway MIB is located in the 
domain\wpgate\exchange directory.

Before you can monitor an SNMP-enabled Exchange Gateway, you must compile the ngwln.mib 
file using your SNMP management program. 

1 Copy the ngwln.mib file from the domain\wpgate\exchange directory to the location required 
by your SNMP management program.

For example, ManageWise users would copy the ngwln.mib file to the 
\mw\nms\snmpmibs\current directory. The Exchange Gateway MIB file includes annotations 
that enhance the Alert functions of ManageWise. For example, the Summary provides more 
detailed information than the Description does in other SNMP management programs. The 
ManageWise annotations are embedded in comments; therefore, they have no affect on other 
SNMP management programs.

ZENworks for Servers users could copy the ngwln.mib file to the \agents\snmp directory in 
the GroupWise software distribution directory.

2 Compile or import the ngwln.mib file as required by your SNMP management program.

For example, to compile the ngwln.mib file for ZENworks for Servers:

2a In ConsoleOne, right-click the Site Server object, then click Properties > MIB Pool.

2b Click Modify Pool > Add.

2c Browse to and select the ngwln.mib file, then click OK.

2d Click Compile.

2e To make sure that the Windows machine where the Exchange Gateway is running is 
configured to send SNMP traps to the ZENworks for Servers Site Server, add the IP 
address or host name of the Site Server to the list of trap destinations.

From the Windows NT Control Panel, double-click Network, then click Services > 
SNMP Service > Properties > Traps.

From the Windows 2000 Control Panel, double-click Administrative Tools, then 
click Services > SNMP Service > Properties > Traps.

Refer to your SNMP management program documentation for specific instructions.

3 Continue with “Configuring the Exchange Gateway for SNMP Monitoring” on page 78.

Configuring the Exchange Gateway for SNMP Monitoring
In order for SNMP monitoring programs to monitor the Exchange Gateway, the Exchange 
Gateway must be configured with a network address and SNMP community string.
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1 Browse to and right-click the Exchange Gateway object, then click Properties.

2 Click GroupWise > Network Address to display the Network Address page.

3 Click the pencil icon to provide the TCP/IP address or hostname of the machine where the 
Exchange Gateway runs, then click Apply.

The Exchange Gateway does not currently support SSL.

4 Click GroupWise > Identification.

5 Provide your system SNMP community GET string, then click OK.

ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

The Exchange Gateway should now be visible to your SNMP monitoring program.
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Notifying the Exchange Gateway Administrator about Bad 
Messages

Occasionally, the Exchange Gateway encounters a message that it cannot process, either because 
the message file has been damaged or because the recipient is not a user that is recognized by the 
gateway. You can use the /badmsg switch in the Exchange Gateway startup file to indicate how 
you want the Exchange Gateway to handle messages that are damaged or undeliverable. 

By default, bad messages are moved to the domain\wpgate\exchange\gwprob directory. If you do 
not want to do anything with bad messages, you can have the gateway delete them immediately, 
or you can have the gateway periodically clean up the gwprob directory, as described in “Setting 
Up Daily Maintenance Tasks” on page 84.

If you want to take a look at bad message files, you can have the gateway send the bad message 
files to the postmaster. If you do not yet have a postmaster, see “Establishing Gateway 
Administrators” on page 64 for setup instructions.

Understanding Exchange Gateway Error Messages
As you monitor the Exchange Gateway, you might occasionally see error messages. Exchange 
Gateway error messages are documented with the source of the error, possible causes of the error, 
and actions to take to resolve the error. See Appendix A, “Error and Informational Messages,” on 
page 93.
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9 Optimizing the Exchange Gateway

You can adjust how the Exchange Gateway functions in order to optimize its performance. Before 
attempting optimization, you should run the Exchange Gateway long enough to observe its 
efficiency and its impact on other network applications running on the same machine. See Chapter 
8, “Monitoring the Exchange Gateway,” on page 67.

Also, remember that optimizing your network hardware and operating system can make a 
difference in Exchange Gateway performance.

The following topics help you optimize the Exchange Gateway:

“Adjusting the Gateway’s Send/Receive Cycle” on page 81

“Adjusting the Number of Sender and Receiver Threads” on page 82

“Automating Network Reattachment” on page 83

“Reducing Network Traffic” on page 84

“Setting Up Daily Maintenance Tasks” on page 84

Adjusting the Gateway’s Send/Receive Cycle
The Exchange Gateway's send/receive cycle determines how much time the gateway spends 
sending messages as opposed to receiving them. The send process refers to messages sent from 
GroupWise® to Exchange; the receive process refers to messages sent from Exchange to 
GroupWise.

The default send/receive cycle is 120 seconds, which causes the gateway to send messages for a 
maximum of 60 seconds and then receive messages for 60 seconds. You can adjust the send/
receive cycle to better suit your environment and needs. You can also adjust some additional time-
related settings for the gateway.

1 In ConsoleOne®, browse to and right-click the Exchange Gateway object, then click 
Properties.

2 Click GroupWise > Gateway Time Settings to display the Gateway Time Settings page.
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3 Fill in the following fields:

Send/Receive Cycle: Specify the maximum amount of time you want the gateway to spend 
sending and receiving messages during one cycle. The default cycle is 120 seconds, which 
causes the gateway to send messages for a maximum of 60 seconds and to receive messages 
for 60 seconds. The cycle is then repeated.

If the time limit is reached and a message is being processed, the gateway finishes processing 
the message.

Minimum Run: This field does not apply to the Exchange Gateway.

Idle Sleep Duration: Specify the number of seconds the gateway is to remain idle if it has no 
commands or messages to process. The default value is 30 seconds.

The gateway constantly polls its directory for messages to process. The purpose of idle time 
is to save CPU cycles and to keep network traffic manageable.

Snap Shot Interval: The Exchange Gateway console shows the gateway statistics for the last 
x minutes (an interval you specify). The default interval is 10 seconds. Gateway activity is 
updated every minute.

4 Click OK to save the updated time settings.

ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

Exchange Gateway Web Console 
You can adjust these settings for the current gateway session on the Time Settings page.

Adjusting the Number of Sender and Receiver Threads
The Exchange Gateway can be configured to start from varying numbers of sender and receiver 
threads, depending on the amount of traffic passing through the gateway. The heavier the traffic, 
the more threads you should configure the gateway to start. By default, 4 sender threads and 4 
receiver threads are started.

Use the /st switch in the Exchange Gateway startup file (gwexch.cfg) to set the number of sender 
threads. Use the /rt switch to set the number of receiver threads.
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Exchange Gateway Web Console 
You can check the number of sender and receiver threads that are currently available and in use on 
the Status page.

Automating Network Reattachment
When the Exchange Gateway loses its link to the server where the GroupWise domain directory 
resides or its link to the Exchange server, it can attempt to reestablish the link.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.

2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.

3 Make sure that Enable Recovery is set to Yes.

4 Fill in the following fields:

Retry Count: Specify the number of times you want the gateway to attempt to recover the 
network link. The default is 10 times.

Retry Interval: Specify the amount of time you want the gateway to wait between retry 
attempts. The default value is 60 seconds.

Failed Recovery Wait: If the gateway cannot reconnect to the network after the number of 
times specified in Retry Count, it stops attempting to reconnect. Specify the amount of time 
you want the gateway to wait until it starts the reconnect process again. The default value is 
3600 seconds (1 hour).

Network Reattach Command: You can create a batch file that the gateway can use to 
reconnect to the network server where the GroupWise domain directory resides and to the 
Exchange/Domino server. Specify the name of the batch file in this field.

5 Click OK to save the reattachment information.

ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.
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Reducing Network Traffic
By default, the Exchange Gateway's queue directories are located in the domain\wpgate\exchange 
directory on the server where the domain is located. If the gateway is not installed on the same 
machine with the domain directory structure, you can reduce network traffic by redirecting the 
gateway's queue directories to the Windows machine where the gateway is running.

If you choose to place the queue directories on the gateway machine's local drive, make sure the 
gateway machine has sufficient disk space, memory, and processing power to handle the load.

Start the gateway using the following startup switch:

exgate.exe /work-queue_directory 

where queue_directory is the path to the directory where you want the gateway queues created. 
For example, you could use a c:\exchgate directory on the local drive. Make sure the directory is 
not used by any other program. The gateway must have exclusive access to the directory; any 
unrecognized files in the directory are immediately moved to the gwprob subdirectory.

The first time you start the gateway using the /work switch, the gateway creates the necessary file 
structure in the specified directory. It creates a wpgate directory, with wpcsin and wpcsout queue 
directories. This local structure is used as long as you continue to start the gateway with the /work 
switch. You might want to add the /work switch to the startup file (gwexch.cfg) so the gateway 
always uses the same queue directory. See Chapter 10, “Using Exchange Gateway Startup 
Switches,” on page 85. 

Setting Up Daily Maintenance Tasks
The Exchange Gateway has the capability of running any maintenance commands you invoke. To 
take advantage of this capability, you must create a batch file called gwmaint.bat and include your 
Windows maintenance commands in it. Each day at midnight, the gateway executes the commands 
in the gwmaint.bat file.

1 Use a text editor to create a gwmaint.bat file in the domain\wpgate\exchange directory.

2 Specify the maintenance commands you want. You can include as many commands as 
necessary.

For example, the file could include the following line to delete any message files that are 
undeliverable or damaged.

del j:\connector\wpgate\exchange\gwprob\*.bad (queue in the domain directory)

or

del c:\lngate\wpgate\exchange\gwprob\*.bad (queue on the local machine)

3 Save the file in the domain\wpgate\exchange directory.
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10 Using Exchange Gateway Startup Switches

Startup switches let you set various operational parameters for the gateway. Some startup switches 
override configuration information, such as logging level, that you can set in ConsoleOne®. Other 
switches provide configuration options not available anywhere else.

To use a startup switch, you can include it on the command line immediately following the 
exgate.exe executable command.

Example: 
exgate.exe /badmsg-send

You can also edit the Exchange Gateway startup file (gwexch.cfg) to include the switches you 
want to use when starting the gateway. The gwexch.cfg file is located in the 
domain\wpgate\exchange directory. Use the following syntax to include the startup file:

Example: 
exgate.exe @gwexch.cfg

The table below summarizes Exchange Gateway startup switches and how they correspond to 
configuration settings in ConsoleOne.

Startup Switch ConsoleOne Setting

/addressrule N/A

/allowdom N/A

/badmsg N/A 

/blockdom N/A

/corr N/A

/custom N/A

/group N/A

/help N/A

/home N/A

/httppassword HTTP Password

/httpport HTTP Port

/httprefresh N/A

/httpuser HTTP Username

/log Log File Path
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/addressrule
Establishes the format of user addresses when sending a busy search request to the Exchange 
system.

Syntax: 
/addressrule-address_format

The address_format variable can be replaced with any combination of the following tags:

<domain> 
<username> 
<firstname> 
<lastname> 
<firstinitial> 
<lastinitial>

See “Setting Up an Addressing Rule to Facilitate Busy Searches” on page 53 for examples.

/allowdom
Affects outbound directory exchange and allows only users in the specified GroupWise domains 
to appear in the Microsoft Exchange address book when directory synchronization and exchange 
are enabled. Users from all unlisted domains are blocked. See “Enabling Directory 
Synchronization and Exchange of Address Books” on page 45

Syntax: 
/allowdom-domain 
/allowdom-"list_of_domains"

Examples: 
/allowdom-domain1 
/allowdom-"domain1, domain2, domain3"

See also /blockdom.
IMPORTANT: Do not use the /allowdom and /blockdom switches together. If both are specified, only the /
allowdom switch takes effect.

/logdays Maximum Log File Age

/loglevel Log Level

/logmax Maximum Log File Size

/recv N/A

/rt N/A

/send N/A

/single N/A

/st N/A

/work N/A

Startup Switch ConsoleOne Setting
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/badmsg
Indicates what the gateway should do with bad message files (undeliverable or damaged). See 
“Notifying the Exchange Gateway Administrator about Bad Messages” on page 80. The following 
options can be used:

Move: Instructs the gateway to move the bad message files to the 
domain\wpgate\exchange\gwprob directory. This is the default action.

Send: Instructs the gateway to send the bad message files to the user assigned as the gateway's 
Postmaster. See “Establishing Gateway Administrators” on page 64. 

Both: Instructs the gateway to both move and send the bad message files.

Neither: Instructs the gateway to delete the files

Syntax: 
/badmsg-option

Example: 
/badmsg-both

/blockdom
Affects outbound directory exchange and prevents users in the specified GroupWise domains from 
appearing in the Exchange Address Book when directory synchronization and exchange are 
enabled. Users from all unlisted domains are allowed. See “Enabling Directory Synchronization 
and Exchange of Address Books” on page 45.

Syntax: 
/blockdom-domain 
/blockdom-"list_of_domains"

Examples: 
/blockdom-domain1 
/blockdom-"domain1, domain2, domain3"

See also /allowdom.

IMPORTANT: Do not use the /allowdom and /blockdom switches together. If both are specified, only the /
allowdom switch takes effect.

/corr
Specifies the path where the correlation database (gwcorr.db) used for message status tracking is 
to be redirected. By default, the correlation database is located in the domain\wpgate\exchange 
directory. For information about the correlation database, see “Enabling Message Status for Sent 
Items” on page 65.

Syntax: 
/corr-[drive:]\directory 
/corr-\\server\sharename\directory

Example: 
/corr-\lngate\statcorr 
/corr-m:\lngate\statcorr 
/corr-\\server2\c$\lngate\statcorr
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/custom
Affects inbound directory exchange and enables synchronization of custom recipients from 
Exchange to GroupWise. See “Enabling Directory Synchronization and Exchange of Address 
Books” on page 45 and “Including Custom Users in Directory Synchronization” on page 53.

Syntax: 
/custom

/group
Turns on group expansion. If enabled, an incoming message addressed to a public group 
(distribution list) are sent to members of that group. Group expansion is on by default.

Syntax: 
/group

/help
Displays information about the Exchange Gateway switches.

Syntax: 
/help

/home
Specifies the path to the gateway root directory (domain\wpgate\exchange). 
IMPORTANT: You cannot move the Exchange Gateway software to a different location.

Syntax: 
/home-[drive:]\directory 
/home-\\server\sharename\directory

Example: 
/home-\exchgate\work 
/work-m:\exchgate\work 
/work-\\server2\c$exchngate\work

/httppassword
Specifies the password for the Exchange Gateway to prompt for before allowing gateway status 
information to be displayed in your Web browser. Do not use an existing Novell® eDirectoryTM 
password because the information passes over the insecure connection between your Web browser 
and the Exchange Gateway. See “Using the Exchange Gateway Web Console” on page 70.

Syntax: 
/httppassword-password

Example: 
/httppassword-GWiseExchange

See also /httpuser, /httpport, and /httprefresh.
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/httpport
Sets the HTTP port number used for the Exchange Gateway to communicate with your Web 
browser. The setting must be unique on the machine where the Exchange Gateway runs. See 
“Using the Exchange Gateway Web Console” on page 70.

Syntax: 
/httpport-port_number

Example: 
httpport-7175

See also /httpuser, /httppassword, and /httprefresh.

/httprefresh
Specifies the rate at which the Exchange Gateway refreshes the status information in your Web 
browser. The default is 60 seconds. See “Using the Exchange Gateway Web Console” on page 70.

Syntax: 
/httprefresh-seconds

Example: 
/httprefresh-30

See also /httpuser, /httppassword, and /httpport.

/httpuser
Specifies the username for the Exchange Gateway to prompt for before allowing gateway status 
information to be displayed in a Web browser. Providing a username is optional. Do not use an 
existing eDirectory username because the information passes over the insecure connection 
between your Web browser and the Exchange Gateway. See “Using the Exchange Gateway Web 
Console” on page 70.

Syntax: 
/httpuser-username

Example: 
/httpuser-GateWatcher

/log
Redirects the log files to the specified directory. By default, the log files are created in the 
domain\wpgate\exchange\000.prc directory. See “Using Exchange Gateway Log Files” on 
page 76.

Syntax: 
/log-[drive:]\directory 
/log-\\server\sharename\directory

Example: 
/log-\lngate\logs 
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/log-m:\lngate\logs 
/log-\\server2\c$\lngate\logs

See also /loglevel, /logdays, and /logmax.

/logdays
Overrides the maximum log file age specified in ConsoleOne. Any log files older than the number 
of days you specify are deleted. The range is from 1 to 360 days. See “Using Exchange Gateway 
Log Files” on page 76.

Syntax: 
logdays-days

Example: 
/logdays-30

See also /log, /loglevel, and /logmax.

/loglevel
Overrides the log level specified in ConsoleOne. Possible options are Off, Normal, Verbose, and 
Diagnostic. See “Using Exchange Gateway Log Files” on page 76.

Syntax: 
/loglevel-level

Example: 
/loglevel-verbose

See also /log, /logdays, and /logmax.

/logmax
Overrides the maximum log file disk space specified in ConsoleOne. If the maximum disk space 
limit is reached, the oldest log file is deleted to make room for a new one. Specify the number of 
kilobytes you want to use. The default is 1024 KB or 1 MB. The range is from 256 KB to unlimited 
size. Use 0 for unlimited disk space. See “Using Exchange Gateway Log Files” on page 76.

Syntax: 
/logmax-kilobytes

Example: 
/logmax-2048

See also /log, /loglevel, and /logdays.

/recv
Puts the gateway in receive-only mode, so that it receives messages from the Exchange system but 
does not send messages to the Exchange system.

Syntax: 
/recv

See also /send.
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/rt
Specifies the number of receiver threads that the Exchange Gateway should start. The default it 4. 
There is no limit to the number of threads you can start, but nothing is gained by starting threads 
that are always idle. See “Adjusting the Number of Sender and Receiver Threads” on page 82.

Syntax: 
/rt-threads

Example: 
/rt-3

See also /st.

/send
Puts the gateway in send-only mode, so that it sends messages to the Exchange system but does 
not receive messages from the Exchange system.

Syntax: 
/send

See also /recv.

/single
Instructs the gateway to run for one send/receive cycle, then shut down. For information about the 
send/receive cycle, see “Adjusting the Gateway’s Send/Receive Cycle” on page 81.

Syntax: 
/single

/st
Specifies the number of sender threads that the Exchange Gateway should start. The default it 4. 
Valid values range from 1 to 4. See “Adjusting the Number of Sender and Receiver Threads” on 
page 82.

Syntax: 
/st-threads

Example: 
/st-3

See also /rt.

/work
Indicates the path where temporary files are stored while messages are transferred. You can use a 
path to a location on the Windows machine where the gateway is running or on the server where 
the domain directory is located. For more information, see “Reducing Network Traffic” on 
page 84.
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Syntax: 
/work-[drive:]\directory 
/work-\\server\sharename\directory

Example: 
/work-\lngate\work 
/work-m:\lngate\work 
/work-\\server2\c$\lngate\work
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A Error and Informational Messages 

This section helps you resolve error messages that appear in Exchange Gateway log files and other 
places where gateway status information is displayed:

“Error Messages” on page 93

“Informational Messages” on page 106

Additional sources of troubleshooting assistance include:

Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)

GroupWise 6.x Support Forums (http://support.novell.com/forums/gw6.html)

GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

Error Messages
Access to a recipient in the message has been denied while processing inbound message
Configuration database not found
Conversion cleanup error while processing inbound message
Conversion error while processing inbound message
Conversion initialization error while processing inbound message
Conversion initialization error while processing outbound message
Could not connect to server share
Could not remove the file named gwproxydll.bak
Error accessing Microsoft Exchange message property while processing inbound message
Error converting addresses between Microsoft Exchange and GroupWise formats while 

processing inbound or outbound message
Exchange server was down while initializing the gateway
Export from Exchange reported problems while performing an inbound directory operation
Foreign domain information not available while performing an inbound directory operation
Foreign host information not available while performing an inbound directory operation
Foreign user information not available while performing an inbound directory operation
Gateway Object Identifier in the registry was invalid while initializing the gateway
Ignoring recipient FirstName/LastName (Bad GroupWise proxy)
Ignoring recipient (No FirstName/LastName) (Bad GroupWise proxy)
MAPI initialization failed while initializing the gateway
Memory allocation failed while performing an inbound directory operation
Memory allocation failed while performing an outbound directory operation
Message server directories do not exist
No active recipients while processing inbound message
No active recipients while processing outbound message
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Unable to access the Microsoft Exchange gateway mailbox
Unable to add data to correlation record while processing inbound message
Unable to commit correlation record while processing inbound message
Unable to construct message while processing inbound message
Unable to convert a directory field while performing an inbound directory operation
Unable to convert attachment while processing inbound message
Unable to convert attachment while processing outbound message
Unable to convert message body while processing inbound message
Unable to create directory
Unable to create correlation record while processing inbound message
Unable to create gateway profile while initializing the gateway
Unable to create message while processing inbound message
Unable to find gateway root directory while performing an outbound directory operation
Unable to find inbound DLL while initializing the gateway
Unable to find outbound DLL while initializing the gateway
Unable to find primary domain name while performing an inbound directory operation
Unable to generate accounting record while processing outbound message
Unable to generate status message while processing inbound message
Unable to get configuration information from registry while initializing the gateway
Unable to get configuration information from Site Addressing object while initializing the gateway
Unable to get configuration information from the MAPI Session while initializing the gateway
Unable to get MAPI Session while initializing the gateway
Unable to locate gateway home directory
Unable to map recipients while processing outbound message
Unable to obtain directory handle while initializing directory operations
Unable to obtain directory handle while performing an outbound directory operation
Unable to open the event log while initializing the gateway
Unable to send Non-Delivery Report while processing inbound message
Unable to set Microsoft Exchange message property while processing outbound message
Undeliverable message while processing inbound message
Unknown message type while processing inbound message

Access to a recipient in the message has been denied while processing inbound message

Source: GroupWise® Exchange Gateway.

Explanation: The sender or the recipient has no access to the gateway.

Action: Verify that the sender or recipient has access to the gateway.

Configuration database not found 

Source: GroupWise Exchange Gateway.

Explanation: The gateway home directory is not defined during the gateway startup.

Action: Run the gateway from the gateway home directory or specify the  /home startup switch correctly 
in the gwexch.cfg file.
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Conversion cleanup error while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to delete the message from the mts-out folder of the gateway mailbox after 
converting it to a GroupWise message.

Action: Verify that the Microsoft Exchange server is running.

Conversion error while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to spawn a thread to convert a message from Exchange to GroupWise 
format. 

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Conversion initialization error while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the configuration parameters for gwin.dll under the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\MAPI Conversions.

Action: Verify that this registry entry exists. If not, reinstall the gateway after uninstalling the previous 
instance of the gateway. See “Uninstalling the Exchange Gateway” on page 42.

Conversion initialization error while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the configuration parameters for gwout.dll under the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\MAPI Conversions.

Action: Verify that this registry entry exists. If not, reinstall the gateway after uninstalling the previous 
instance of the gateway. See “Uninstalling the Exchange Gateway” on page 42.

Could not connect to server share

Source: GroupWise Exchange Gateway.

Explanation: Permissions do not exist on the server for remote login during installation.

Action: Set appropriate permissions on the Windows NT server to enable remote login.

Explanation: Network problems are preventing access to the server share during installation.

Action: Check the network status.
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Could not remove the file named gwproxydll.bak

Source: GroupWise Exchange Gateway.

Explanation: If you are installing a new version of the gateway while an older version of the gateway exists on 
the server, the Installation program tries to replace the gwproxy.dll, but the process cannot be 
completed because the existing version of gwproxy.dll is loaded into memory.

Action: Remove gwproxy.dll from memory. You can do this by stopping the System Attendant service and 
restarting it immediately. You can then click Retry. Do not click Retry before the services and their 
dependencies have started. 

Error accessing Microsoft Exchange message property while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The message might be damaged.

Action: Send the message again.

Explanation: The Exchange server might not be running. 

Action: Verify that the Microsoft Exchange server is running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Error converting addresses between Microsoft Exchange and GroupWise formats while processing 
inbound or outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to locate the Exchange address table to map addresses between Exchange 
and GroupWise formats.

Action: Verify that the GWISE address type is installed. See Chapter 4, “Configuring the Exchange Side 
of the Exchange Gateway,” on page 27.

Action: Verify that the Exchange server is running. See Chapter 4, “Configuring the Exchange Side of the 
Exchange Gateway,” on page 27.

Exchange server was down while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Exchange server services are not running.

Action: Run the Exchange server services as described in Chapter 4, “Configuring the Exchange Side of 
the Exchange Gateway,” on page 27, then restart the gateway. See “Starting the Exchange 
Gateway” on page 39.

Export from Exchange reported problems while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The export of user objects from Exchange has encountered a problem. The gateway is unable to 
obtain objects to exchange with the GroupWise system.

Action: Any corruption in the Exchange system needs to be identified and corrected.
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Foreign domain information not available while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The domain information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See “Installing the Exchange Gateway 
Addressing Components” on page 22.

Foreign host information not available while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The host information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See “Installing the Exchange Gateway 
Addressing Components” on page 22.

Foreign user information not available while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The user information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See “Installing the Exchange Gateway 
Addressing Components” on page 22.

Action: Ensure that the address format for GWISE contains %m as a component. See “Selecting User 
Address Type and Format” on page 19 and Chapter 4, “Configuring the Exchange Side of the 
Exchange Gateway,” on page 27.

Gateway Object Identifier in the registry was invalid while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Gateway Object Identifier in the registry no longer matches a gateway object in the Exchange 
Directory.

Action: Uninstall the old gateway and reinstall the gateway. See “Uninstalling the Exchange Gateway” on 
page 42 and Chapter 3, “Installing the Exchange Gateway,” on page 15.

Ignoring recipient FirstName/LastName (Bad GroupWise proxy)

Source: GroupWise Exchange Gateway.

Explanation: Every Exchange recipient object has a GroupWise-type address generated for it when the gateway 
starts for the first time. If for some reason, this address could not be created, the user cannot be 
exchanged/synchronized with GroupWise because vital information is missing.

Action: View the application event log (Start > Programs > Administrative Tools > Event Viewer) for 
reasons as to why  the address was not created. Reasons could include invalid characters, absence 
of vital components such as the mailbox name, and so forth.

Explanation: A GroupWise-type address for the recipient object exists but the address has a domain name that 
is the same as that of the GroupWise primary domain name.
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Action: If this is a problem with most of the objects, then you might need to change the address format for 
GWISE. See “Determining Connections between Systems” on page 19, “Selecting User Address 
Type and Format” on page 19, and Chapter 4, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 27.

Ignoring recipient (No FirstName/LastName) (Bad GroupWise proxy)

Source: GroupWise Exchange Gateway.

Explanation: Every Exchange recipient object has a GroupWise-type address generated for it when the gateway 
starts for the first time. If for some reason, this address could not be created, the user cannot be 
exchanged or synchronized with GroupWise because vital information is missing.

Action: View the application event log (Start > Programs > Administrative Tools > Event Viewer) for 
reasons as to why the address was not created. Reasons could include invalid characters, absence 
of vital components such as the mailbox name, and so forth.

Explanation: A GroupWise-type address for the recipient object exists but the address has a domain name that 
is the same as that of the GroupWise primary domain name.

Action: If this is a problem with most of the objects, then you might need to change the address format for 
GWISE. See “Determining Connections between Systems” on page 19, “Selecting User Address 
Type and Format” on page 19, and Chapter 4, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 27.

MAPI initialization failed while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The MAPI subsystem does not exist or is corrupted.

Action: Reinstall the MAPI subsystem.

Memory allocation failed while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: Insufficient memory to perform the current operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Memory allocation failed while performing an outbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: Insufficient memory to perform the current operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.
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Message server directories do not exist

Source: GroupWise Exchange Gateway.

Explanation: The GroupWise Message Transfer Agent (MTA) is not running or the gateway has not been 
configured on the GroupWise system.

Action: Start the MTA for the domain that the gateway belongs to. See “Starting the MTA” in “Message 
Transfer Agent” in the GroupWise 6.5 Administration Guide.

Action: Check the GroupWise configuration in ConsoleOne to ensure that the gateway object exists and is 
correctly configured. See “Providing Gateway Information” on page 36.

No active recipients while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not determine who to route the message to.

Possible Cause: The message might be damaged.

Action: Resend the message.

Possible Cause: The sender or recipient might not have access to the gateway.

Action: Verify that sender or recipient has access to the gateway. See “Controlling Gateway Access” on 
page 54.

No active recipients while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not determine who to route the message to.

Possible Cause: The message might be damaged.

Action: Resend the message.

Possible Cause: The sender or recipient might not have access to the gateway.

Action: Verify that sender or recipient has access to the gateway. See “Controlling Gateway Access” on 
page 54.

Unable to access the Microsoft Exchange gateway mailbox 

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in or mts-out folder in the gateway's Mailbox in the 
Exchange system during inbound or outbound message processing.

Action: Verify that all Exchange server services are running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Action: Verify that the user logged into Windows has enough rights to the Exchange system and the 
Mailbox store. See Chapter 4, “Configuring the Exchange Side of the Exchange Gateway,” on 
page 27.

Unable to add data to correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).
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Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database with new records.

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message status information but 
re-creates a valid correlation database. For more information, see “Enabling Message Status for 
Sent Items” on page 65.

Unable to commit correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database.

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message status information but 
re-creates a valid correlation database. For more information, see “Enabling Message Status for 
Sent Items” on page 65.

Unable to construct message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to add a GroupWise field to the message.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Unable to convert a directory field while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway encountered a damaged field during conversion.

Action: None. The field might not have been exchanged.

Unable to convert attachment while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.
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Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment.

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Unable to convert attachment while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.

Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Unable to convert message body while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.

Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Unable to create directory

Source: GroupWise Exchange Gateway.

Explanation: The directory could not be created during the installation because of transient network problems.

Action: Click Retry in the pop-up. 

Action: If the problem persists, manually reconnect to the server and try installing again.

Unable to create correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database.

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.
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Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message status information but 
re-creates a valid correlation database. For more information, see “Enabling Message Status for 
Sent Items” on page 65.

Unable to create gateway profile while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: A profile with the same name might already exist.

Action: Restart the gateway so that a profile is created with a different name.

Unable to create message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot create a message file in its output queue.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space for the gateway to process message files in its queues 
(wpcsin and wpcsout).

Action: Make sure that the gateway machine meets the disk space requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Possible Cause: The gateway might not have sufficient access rights to the gateway's wpcsin directory.

Action: Verify that the gateway has sufficient access rights to the MTA input queue in the domain.

Unable to find gateway root directory while performing an outbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway root directory (domain\wpgate\exchange) could not be found.

Action: Use the /home startup switch to specify the gateway root directory correctly in the gwexch.cfg file, 
then start the gateway. See “Starting the Exchange Gateway” on page 39.

Unable to find inbound DLL while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway requires gwin.dll but is unable to find it.

Action: Add the  domain\wpgate\exchange directory to the path variable on the machine where the 
Gateway runs.

At the gateway machine:

1 Right-click My Computer, then click Properties.

2 Click Environment.

3 In the User Variables for Administrator list, add the domain\wpgate\exchange to the end of 
the path variable value.

4 Click Set, then click OK.
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Unable to find outbound DLL while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway requires gwout.dll but is unable to find it.

Action: Add the  domain\wpgate\exchange directory to the path variable on the machine where the 
Gateway runs.

At the gateway machine:

1 Right-click My Computer, then click Properties.

2 Click Environment.

3 In the User Variables for Administrator list, add the domain\wpgate\exchange to the end of 
the path variable value.

4 Click Set, then click OK.

Unable to find primary domain name while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to find primary domain information while trying to add or detect the 
foreign domain.

Possible Cause: The situation is rare and the problem might be due to internal database damage.

Action: None. 

Unable to generate accounting record while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not update the acct file.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Unable to generate status message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder of the gateway mailbox in Microsoft Exchange.

Action: Verify that the Exchange server services are running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Unable to get configuration information from registry while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the gateway's Message Store in Exchange 5.x/2000.

Possible Cause: The Exchange server services might not be running.
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Action: Verify that all Exchange server services are running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Possible Cause: The user logged into Windows with insufficient rights to the Exchange system and the Mailbox 
store.

Action: Verify that the user logged into Windows has enough rights to the Exchange system and the 
Mailbox store. See Chapter 4, “Configuring the Exchange Side of the Exchange Gateway,” on 
page 27.

For Exchange 5.x, the user logged into Windows should be a member of the Administrators, 
Domain Admins, and Domain Users groups and should have administrator permissions to the 
Exchange Organization, Site, and Configuration container property pages of the Exchange Server.

For Exchange 2000, the user logged into Windows should be member of the Administrators, 
Domain Admins, and Enterprise Admins group and should have enough rights to the Exchange 
system. See “Configuring Exchange 2000” on page 30.

Unable to get configuration information from Site Addressing object while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Microsoft Exchange server services might not be running.

Action: Run the Microsoft Exchange server services as described in Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27, then restart the gateway.

Unable to get configuration information from the MAPI Session while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the gateway's Message Store in Microsoft Exchange during 
initialization in Microsoft Exchange 5.x or 2000.

Possible Cause: The Exchange server services might not be running.

Action: Verify that all Exchange server services are running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Possible Cause: The user logged into Windows with insufficient rights to the Exchange system and the Mailbox 
store.

Action: Verify that the user logged into Windows has enough rights to the Exchange system and the 
Mailbox store. See Chapter 4, “Configuring the Exchange Side of the Exchange Gateway,” on 
page 27.

For Exchange 5.x, the user logged into Windows should be a member of the Administrators, 
Domain Admins, and Domain Users groups and should have administrator permissions to the 
Exchange Organization, Site, and Configuration container property pages of the Exchange Server.

For Exchange 2000, the user logged into Windows should be member of the Administrators, 
Domain Admins, and Enterprise Admins group and should have enough rights to the Exchange 
system. See “Configuring Exchange 2000” on page 30.

Unable to get MAPI Session while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: Too many sessions have been opened simultaneously.

Action: Close unused sessions and restart the gateway.
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Unable to locate gateway home directory

Source: GroupWise Exchange Gateway.

Explanation: The gateway home directory not defined.

Action: Run the gateway from the gateway home directory or specify the  /home startup switch correctly 
in the gwexch.cfg file.

Unable to map recipients while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot identify the Exchange recipients the message is being sent to.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Unable to obtain directory handle while initializing directory operations

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to obtain a DAPI session.

Action: Check the application event log (Start > Programs > Administrative Tools > Event Viewer) for 
details of the problem.

Unable to obtain directory handle while performing an outbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to obtain a DAPI session

Action: Check the application event log (Start > Programs > Administrative Tools > Event Viewer) for 
details. 

Unable to open the event log while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The EventLog service might not be running.

Action: Run the EventLog service and restart the gateway.

Unable to send Non-Delivery Report while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder in the gateway mailbox.

Action: Verify that the Microsoft Exchange server is running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.
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Unable to set Microsoft Exchange message property while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder of the gateway mailbox in Microsoft Exchange.

Possible Cause: The Exchange server services might not be running.

Action: Verify that the Exchange server services are running. See Chapter 4, “Configuring the Exchange 
Side of the Exchange Gateway,” on page 27.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway machine might have too many applications running.

Action: Stop some applications or move them to a different machine.

Possible Cause: The gateway machine might not meet the system memory requirements listed in Chapter 2, 
“Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Undeliverable message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The GroupWise recipient address is invalid.

Action: Verify that the recipient exists in the GroupWise domain by looking up the user in the GroupWise 
Address Book.

Unknown message type while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway does not recognize the type of message file it has received from the Exchange system.

Possible Cause: The message file is damaged.

Action: Resend the message.

Possible Cause: The gateway is working with a Microsoft Exchange system version with which it is not 
compatible.

Action: See Chapter 2, “Exchange Gateway System Requirements,” on page 13 for a list of supported 
Exchange versions.

Informational Messages
Processing <first name last name>
Processed XXX Exchange recipients
Number of Additions/Modifications: XXX
Number of Deletions: XXX
Number of Domains Allowed: XXX
Number of Domains Blocked: XXX
Number of Ignores: XXX
Total Number Processed: XXX
Some GroupWise records have not been written to the Exchange directory
Some Exchange objects have not been written to the GroupWise directory
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Processing <first name last name>

Source: GroupWise Exchange Gateway.

Explanation: The first name and last name of the object currently being processed during inbound directory 
exchange.

Processed XXX Exchange recipients

Source: GroupWise Exchange Gateway.

Explanation: Status message that is displayed for every 50 Exchange recipients processed when the logging is 
set to Verbose mode.

Number of Additions/Modifications: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of additions or modifications processed during the current directory exchange 
operation.

Number of Deletions: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of deletions processed during the current directory exchange operation. For an 
inbound directory exchange operation, this includes all the tombstones that were processed, not 
necessarily the number of deletions made in the GroupWise® Address Book.

Number of Domains Allowed: XXX

Source: GroupWise Exchange Gateway.

Explanation: This message appears if the /allowdom switch is in effect and valid domain names have been 
supplied. It provides statistics on the actual number of domains that were allowed during outbound 
directory exchange.

Number of Domains Blocked: XXX

Source: GroupWise Exchange Gateway.

Explanation: This message appears if the /blockdom switch is in effect and valid domain names have been 
supplied. It provides statistics on the actual number of domains that were blocked during outbound 
directory exchange.

Number of Ignores: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of ignored objects or records during the current directory exchange operation. For the 
inbound directory operation, all GroupWise custom recipients are ignored and for the outbound 
directory operation all foreign recipients under the Exchange foreign domain are ignored.

Total Number Processed: XXX

Source: GroupWise Exchange Gateway.

Explanation: The total number of records or objects obtained and processed during the current directory 
exchange operation.
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Some GroupWise records have not been written to the Exchange directory

Source: GroupWise Exchange Gateway.

Explanation: During the outbound directory operation, errors might have occurred which prevented all records 
obtained from being exchanged. This happens when the total of the additions, modifications, 
deletions, and ignores does not match the total number processed.

Some Exchange objects have not been written to the GroupWise directory

Source: GroupWise Exchange Gateway.

Explanation: During the inbound directory operation, errors might have occurred which prevented all objects 
obtained from being exchanged. This happens when the total of the additions, modifications, 
deletions, and ignores does not match the total number processed.
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B Exchange Gateway Directory Structure

The following directory structure diagrams help you understand the Exchange Gateway:

“Exchange Server Directory Structure” on page 109

“Exchange Gateway Directory Structure under the Domain” on page 110

Exchange Server Directory Structure
When you run the Exchange Gateway, it adds a file to the Exchange installation directory.

exchsvr directory
The exchsvr directory is the standard directory to which Microsoft Exchange is installed on a 
server. On Windows 2000, it is located in the Program Files directory. On Windows NT, it is 
located at the root.

address directory
The address directory contains a subdirectory for each address type that defined in the Exchange 
system. In addition the GroupWise address type, address types include SNMP, cc:Mail, and 
X.400.

gwise\i386 directory

The gwise\i386 directory is where the Exchange Gateway Installation program installs the 
program that makes GroupWise users addressable in the Exchange system.

gwproxy.dll file

The gwproxy.dll file is the program that generates GroupWise-type addresses for all Exchange 
users.

 program files\exchsvr    

 address 

 gwise\i386 

 gwproxy.dll

Exchange Server installation directory 

Subdirectory for addressing-related files 

Subdirectory for files that support the GroupWise® address type 

Program that generates GroupWise addresses from Exchange 
addresses
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Exchange Gateway Directory Structure under the Domain
The Exchange Gateway is installed in a subdirectory of the domain it belongs to.

 
domain\wpgate\exchange

Exchange Gateway root directory

 000.prc 

 mmddlog.nnn 

 cmd 

 gwwork

Directory for message processing 

Exchange Gateway log files 

Not used in version 2.0 of the Exchange Gateway 

Working directory for processing messages

 gwhold 

 qfiles

Directory for retaining delayed delivery messages 

Not used in version 2.0 of the Exchange Gateway

 gwprob Directory for undeliverable messages

 ds 

 gwds

Directory for directory synchronization files 

Directory synchronization file

 dx 

 gwdx

Directory for directory exchange files 

Directory exchange file

 uninstexchange Directory for the Exchange Gateway uninstallation program

 wpcsin 

 0-7

MTA input queue directory 

Priority queue subdirectories

 wpcsout 

 excxxxx 

 0-7 

 problem

MTA output queue directory 

Exchange Gateway input queue 

Priority queue subdirectories 

Undeliverable messages

 readme.txt Readme file

 exgate.exe 

 gwexch.cfg 

 access.cfg 

 gwcorr.*

Exchange Gateway program  

Exchange Gateway startup file 

Access control configuration file 

Status message correlation database

 acct 

 stat

Accounting file 

Statistics file

 gwmaint.bat Gateway maintenance batch file
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domain\wpgate\exchange directory
The Exchange Gateway root directory is the default location for all Exchange Gateway files. 
During installation, you choose the domain where you want to install the Exchange Gateway and 
you choose the name of the root directory. The default directory name is exchange.

To improve performance if you installed the Exchange Gateway on a Windows machine remote 
from the domain directory (for example, if the domain directory is located on a NetWare® server), 
you can move the queue directories from the domain directory to the Windows machine where the 
gateway is running, as described in “Reducing Network Traffic” on page 84.

000.prc directory

The 000.prc directory is where the Exchange Gateway processes messages that are passing 
through the gateway between the GroupWise and Exchange systems.

mmddlog.nnn files

The mmddlog.nnn files are the Exchange Gateway log files where message routing information is 
recorded. See “Using Exchange Gateway Log Files” on page 76.

gwwork directory

The gwwork directory holds temporary files used in message processing.

gwhold directory

The gwhold directory is where delayed delivery messages are held until their delivery times arrive.

gwprob directory

The gwprob directory is where the Exchange Gateway places incoming message files that it cannot 
process. Using the /badmsg switch, you can configure the gateway to retain bad messages, delete 
bad messages, or send bad messages to the gateway postmaster. See “Notifying the Exchange 
Gateway Administrator about Bad Messages” on page 80.

ds directory

The ds directory helps the gateway keep track of whether or not directory synchronization has been 
performed.

 ngwexh.mib Exchange Gateway MIB file

 gwexgate.chm 

 novell_ex.hs 

 map.jhm 

 *.htm

Windows help file for the Exchange Gateway console 

JavaHelp helpset file for Gateway Administrator snap-in help 

Map file for Gateway Administrator snap-in help 

Help topics for Gateway Administrator snap-in help

 gwstrs.fil Exchange Gateway resource file

 *.dll Supporting Windows DLL programs
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gwds file

The gwds file indicates that directory synchronization has taken place. If you delete the gwds file 
and restart the gateway, the gateway performs directory synchronization immediately and then 
recreates the file.

dx directory

The dx directory helps the gateway keep track of whether or not directory synchronization has 
been performed.

gwdx file

The gwdx file indicates that directory synchronization has taken place. If you delete the gwds file 
and restart the gateway, the gateway performs directory exchange immediately and then recreates 
the file.

uninstexchange directory

The uninstexchange directory contains the Exchange Gateway uninstallation program and 
supporting files.

wpcsin directory

The wpcsin directory is the MTA input queue where the Exchange Gateway places messages from 
Exchange users for transfer into the GroupWise system. When a new message arrives, the MTA 
for the domain where the gateway is installed routes it to the appropriate destination. The wpcsin 
directory in the Exchange Gateway directory is parallel to the wpcsin directory in the domain. See 
“Domain Directory” in the GroupWise 6.5 Troubleshooting 3: Message Flow and Directory 
Structure for more information.

The MTA input queue contains eight priority subdirectories.

0-7 priority directories

The 0-7 priority subdirectories in the MTA input queue handle different types of messages 
transferring from the Exchange system into the GroupWise system.

0: Not used by the Exchange Gateway

1: Not used by the Exchange Gateway

2: High priority messages from Exchange users to GroupWise users

3: Status messages notifying Exchange users about the status of high priority messages sent 
to GroupWise users

4: Normal priority messages from Exchange users to GroupWise users

5: Status messages notifying Exchange users about the status of normal priority messages sent 
to GroupWise users 

6: Low priority messages from Exchange users to GroupWise users

7: Status messages notifying Exchange users about the status of low priority messages sent to 
GroupWise users 

Status message correlation must be enabled in order for Exchange users to receive status 
information about messages sent to GroupWise users. See “Enabling Message Status for Sent 
Items” on page 65.
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wpcsout directory

The wpcsout directory is the MTA output queue where the MTA for the domain where the gateway 
is installed places messages for transfer over to the Exchange system. 

excxxxx directory

The excxxxx directory contains eight priority subdirectories.

0-7 priority directories 
The 0-7 priority subdirectories in the MTA output queue handle different types of messages 
transferring from the GroupWise system into the Exchange system.

0: Busy searches from GroupWise users on Exchange users

1: Not used by the Exchange Gateway

2: High priority messages from GroupWise users to Exchange users

3: Status messages notifying GroupWise users about the status of high priority messages sent 
to Exchange users 

4: Normal priority messages from GroupWise users to Exchange users

5: Status messages notifying GroupWise users about the status of normal priority messages 
sent to Exchange users 

6: Low priority messages from GroupWise users to Exchange users

7: Status messages notifying GroupWise users about the status of low priority messages sent 
to Exchange users 

Status message correlation must be enabled in order for GroupWise users to receive status 
information about messages sent to Exchange users. See “Enabling Message Status for Sent Items” 
on page 65.

problem directory

The problem directory is where the MTA places message files that it cannot deliver into one of the 
eight priority subdirectories, perhaps because the message files have been damaged.

readme.txt file

The readme.txt file describes issues and limitations of the Exchange Gateway.

exgate.exe file

The exgate.exe file is the Exchange Gateway executable file. You run this program to start the 
Exchange Gateway. See “Starting the Exchange Gateway” on page 39.

gwexch.cfg file

The gwexch.cfg file is the Exchange Gateway startup file where you can use startup switches to 
configure the Exchange Gateway. See Chapter 10, “Using Exchange Gateway Startup Switches,” 
on page 85.

access.cfg file

The access.cfg file is the Exchange Gateway access control file where you can control access 
through the gateway. See “Controlling Gateway Access” on page 54.
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acct file

The acct file is the accounting file where information about messages passing through the gateway 
is recorded. See “Setting Up Accounting” on page 61.

stat file

The stat file is the gateway statistics file that contains the statistics information displayed on the 
Exchange Gateway console. See “Using the Exchange Gateway Console” on page 67.

gwcorr.* files

The gwcorr.db file is the message status correlation database that enables message status 
information to be exchanged between GroupWise users and Exchange users. See “Enabling 
Message Status for Sent Items” on page 65.

The gwcorr.dc file is the data dictionary file from which the gwcorr.db file is created.

gwmaint.bat file

The gwmaint.bat file is run by the Exchange Gateway each night to perform whatever server 
maintenance tasks you place in it. See “Setting Up Daily Maintenance Tasks” on page 84.

ngwexh.mib file

The ngwexh.mib file is used if you configure the Exchange Gateway for SNMP. See “Using 
SNMP Monitoring Programs” on page 77.

gwexgate.chm file

The gwexgate.chm file is the Windows help file that is available from the Exchange Gateway 
console.

novell_ex.hs file

The novell_ex.hs file is the JavaHelp helpset file for the Exchange Gateway help available in 
ConsoleOne®. 

map.jhm file

The map.jhm file is the JavaHelp map file that maps contexts to Exchange Gateway help topics in 
ConsoleOne.

*.htm files

The *.htm files are the Exchange Gateway help topics that are available in ConsoleOne.

gwstrs.fil file

The gwtrs.fil file is the strings resource file used by the Exchange Gateway console on the 
Windows machine where the gateway runs.

*.dll files

The *.dll files are supporting programs that provide specialized functionality to the Exchange 
Gateway.
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C Documentation Updates

This section lists updates to the Exchange Gateway Installation and Administration Guide that 
have been made since the initial release of the Exchange Gateway 2.0. The information helps you 
to keep current on documentation updates and, in some cases, software updates (such as a Support 
Pack release).

The information is grouped according to the date when the Exchange Gateway Installation and 
Administration Guide was republished. Within each dated section, the updates are listed by the 
names of the main table of contents sections.

The Exchange Gateway Installation and Administration Guide has been updated on the following 
dates:

“July 16, 2004” on page 115

July 16, 2004

Location Change

Chapter 1, “What Is the 
GroupWise Gateway for 
Microsoft Exchange?,” on 
page 11

Clarified that Busy Search is supported for GroupWise users who want 
to check the calendars of Exchange users, but it is not supported for 
Exchange users to check GroupWise users’ calendars.

“Deciding Where to Install 
the Exchange Gateway” on 
page 16

Clarified that the Exchange Gateway must be installed on an Exchange 
server.

“Installing the Exchange 
Gateway Software” on 
page 21

Clarified that the Exchange Gateway must be installed on an Exchange 
server.

“Exchange Gateway 
Directory Structure under 
the Domain” on page 110

Removed reference to Busy Searches on GroupWise® users by 
Exchange users. Busy Searches cannot be performed from the 
Exchange site, only from the GroupWise site.
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